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Introduction

NeXTSTEP™ Development Tools and Techniques describes the essential tools for
developing a NeXTSTEP application—these tools include the Project Builder, Interface
Builder™, Terminal, and Edit applications, miscellaneous developer applications, and the
GNU C compiler, preprocessor, and debugger. The manual is part of a collection of
manuals called the NeXTSTEP Developer’s Library.

This manual assumes you’re familiar with the standard NeXTSTEP user interface.
Experience using a variety of NeXTSTEP applications would also be helpful. Some topics
that are discussed here aren’t covered in detail; instead, you're referred to a generally
available book on the subject, or to an on-line source of the information.

A version of this manual is stored on-line in the NeXT™ Digital Library (which is described
in the User’s Guide). The Digital Library also contains release notes, which provide
last-minute information about the latest release of the software.
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How This Manual is Organized
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The first 14 chapters of this manual concentrate on the tools used in building a
NeXTSTEP application. The last four chapters contain step-by-step instructions for
creating several simple applications, thereby providing a hands-on overview of the
application development process.

Chapter 1, “Putting Together a NeXT Application,” provides an overview of the tools
and techniques that you’ll use to assemble a working application. The tools introduced
in this chapter are discussed in greater detail in other chapters of this manual.

Chapter 2, “The Project Builder Application,” describes the central control point for
application development in NeXTSTEP. Project Builder helps you with each stage of
application development, from inception to installation.

Chapter 3, “The Interface Builder Application,” describes the tool that lets you assemble
your application’s user interface (and other parts) from predefined building blocks, and
lets you create new building blocks of your own design.

Chapter 4, “The Edit Application,” describes the NeXTSTEP text editor you’ll be using
to edit and debug your application’s source files.

Chapter 5, “The Terminal Application,” describes the application you’ll use to interact
with a UNIX® shell from the NeXTSTEP workspace.

Chapter 6, “The Icon Builder Application,” describes a simple graphic editor for
creating and editing application icons.

Chapter 7, “The DBModeler Application,” describes an application for building
data models based on the structure of an existing relational database. The resulting
models can be used in Interface Builder to construct applications that access the data
in the database.

Chapter 8, “The MallocDebug Application,” describes an application for measuring the
dynamic memory usage of the applications you develop.

Chapter 9, “The Process Monitor Application,” describes an application that lets you
examine running processes, and pause or kill any of the processes and applications
running on your computer.



Chapter 10, “The PostScript® Previewers Yap and pft,” describes two tools: an
application for developers who want to write and test PostScript code, and a shell-based
interface to the PostScript Window Server.

Chapter 11, “The GNU C Compiler,” describes GNU CC, the ANSI-standard
C compiler used on NeXT computers. The chapter also describes how to compile
a C program using the GNU compiler. ‘

Chapter 12, “The GNU C Preprocessor,” describes the macro preprocessor that’s used
to transform your C program or application before actual compilation. The chapter
provides information about standard and precompiled header files, macros, and
conditionals. It also lists the options that can be used with the epp (C preprocessor)
command.

Chapter 13, “The GNU Source-Level Debugger,” describes GDB, the primary tool
you’ll use to debug the applications that you develop.

Chapter 14, “Mach Object Files,” describes the format of Mach object (also known as
Mach-O) files, which NeXT computers use instead of the UNIX 4.3BSD a.out format.

Chapter 15, “Building a Simple Application,” provides a tutorial introduction to the
process of application development in NeXTSTEP. It gives you an introduction to
Project Builder and Interface Builder, while showing you some of the basic features of
the Application Kit.

Chapter 16, “Building a One-Button Calculator,” continues the tutorial introduction to
the major development tools in NeXTSTEP and gives you further insight into
object-oriented programming with the Application Kit™.

Chapter 17, “Building a Text Editor Using Multiple Nib Files,” shows how Interface
Builder and the Application Kit are used to tackle more advanced issues of
object-oriented application design.

Chapter 18, “Building a Custom Palette,” the final tutorial in the series, shows you
how Interface Builder itself can be modified to include the objects and tools you find
most useful.
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Conventions
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Syntax Notation

Where this manual shows the syntax of a function, command, or other programming
element, the use of bold, italic, square brackets, and ellipsis has special significance, as
described here.

Bold denotes words or characters that are to be taken literally (typed as they appear). Italic
denotes words that represent something else or can be varied. For example, the syntax

print expression
means that you follow the word print with an expression.

Square brackets [ ] mean that the enclosed syntax is optional, except when they’re bold [ ],
in which case they’re to be taken literally. The exceptions are few and will be clear from
the context. For example,

pointer [filename]

means that you type a pointer with or without a file name after it, but
[receiver message]

means that you specify a receiver and a message enclosed in square brackets.

Ellipsis (...) indicates that the previous syntax element may be repeated. For example:

Syntax Allows

pointer ... One or more pointers

pointer [, pointer] ... One or more pointers separated by commas

pointer [filename ...] A pointer optionally followed by one or more file names

pointer [, filename] ... A pointer optionally followed by a comma and one or more
- file names separated by commas



Special Characters

In general, notation like

Alternate-x

represents the character you get when you hold down the Alternate key while typing x.
Because the modifier keys Alternate, Command, and Control interpret the case of letters
differently, their notation is somewhat different:

Notation
Alternate-x

Alternate-X

Alternate-Shift-x

Command-d

Command-Shift-D

Control-X

Meaning
Hold down Alternate while typing lowercase x.

Hold down Alternate while typing uppercase X (with either
Shift or Alpha Lock).

Same as Alternate-X.

Hold down Command while typing lowercase d; if Alpha
Lock is on, pressing the D key will still produce lowercase d
when Command is held down.

Hold down Command and Shift while pressing the D key.
Alpha Lock won’t work for producing uppercase D in
this case.

Hold down Control while pressing the X key, with or
without Shift or Alpha Lock (case doesn’t matter with
Control).

Notes and Warnings

Note: Paragraphs like this contain incidental information that may be of interest to curious
readers but can safely be skipped.

Warning: Paragraphs like this are extremely important to read.
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Putting logether a NeX1TSTEP
Application

There are a number of ways you might draw the line between programs and applications.
Programs are simple; applications are complicated. Programs are small; applications are
big. Programs run from a command line; applications have a graphic user interface. A
program has just a few source files; an application may have lots and lots.

No matter how you draw the line, as you move from writing programs to developing
applications, you need to focus increasing attention on project management. If the
application is the end result, the project is how you get there. The project can be thought
of as both the steps you go through and the source files you use to construct an application.

A complete project management strategy includes strategies for creating, organizing, and
maintaining source files, building the application from its sources, running and debugging
the application, revising the source files to fix bugs, and installing the finished
application—or preparing it for others to install.

In NeXTSTEP, the hub of application development is Project Builder—a project manager
that is itself a NeXTSTEP application. Project Builder isn’t the only tool you use to
manage your project and develop your application. Instead, it’s like a control center from
which you switch from one application development task to another, and from one tool

to another. ’

This chapter takes a brief look at the components of a NeXTSTEP application. It
explains the path that Project Builder and other NeXTSTEP tools offer you for going from
a set of source files to a working application. It looks at the application development
process in terms of resources and tasks that you, the developer, must provide and those that
Project Builder and other NeXTSTEP tools provide for you. Subsequent chapters present
detailed reference for each of the tools introduced here. The last four chapters present
step-by-step tutorials that offer you a chance to explore the NeXTSTEP development
process for yourself.
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The Application Development Process
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The process of developing an application can be divided into three general tasks:
designing, coding, and debugging. These tasks are never performed entirely sequentially.
You may decide after some coding that you need to change some aspect of design.
Debugging always reveals code that needs rewriting, and occasionally exposes design
flaws. When you develop an application with NeXTSTEP, you can move easily among
these tasks.

The following sections enumerate the components of the NeXTSTEP application
development process, describing those portions for which you’re responsible and those
which Project Builder, Interface Builder, and other NeXTSTEP development tools handle
for you. For more information on Project Builder, see Chapter 2; for more on Interface
Builder, see Chapter 3.

Design Your Application

Before you write any code, you should spend some time thinking about design. Some
components of application design to consider are functionality, program structure, and user
interface. You should think about the goals of your application and the techniques you
might use to meet those goals. You should determine the unique classes that your
application will require and think about how to divide your program into separate modules.
You should sketch out user interface ideas, and use Interface Builder to prototype and test
those ideas.

Create a Project

With the basic design determined, you can use Project Builder to start a new project.

In NeXTSTEDP, a project is physically represented by a directory under the control of
Project Builder; all of the components of the project must reside in this directory. When
you start a new project, Project Builder automatically generates the project directory and a
set of source files common to all applications, including a main file, a nib file, a makefile,
and others. The main file includes the standard main() function required in all C programs.
The nib file is used by Interface Builder to archive the application’s user interface (nib is an
acronym for “NeXTSTEP Interface Builder”). The makefile is updated by Project Builder
to keep track of all the source files from which your application is built. Another file in the
project directory, PB.project, is used by Project Builder itself to keep track of various
project components.

Chapter 1: Putting Together a NeXTSTEP Application



Throughout the life of the project, you will add to and update the files in the project
directory. NeXTSTEP development tools, including Project Builder and Interface Builder
may add to and maintain other files in this directory as your project grows.

Write Code for Your Application

To establish the unique workings of your application, you create class interface and
implementation files that include code for the appropriate methods and instance variables.
Interface Builder can help in this process by creating skeletal code for a class if you list the
methods in the Inspector panel. If you create the source files first, Interface Builder can
parse them to learn about their id instance variables and action methods.

Project Builder lets you add source files to your project at any time. You can create

other source files using standard C, Objective C, and C++ code. Project Builder can also
know about and manage other files, such as pswrap files containing PostScript code within
C function wrappers.

Connect Objects with Interface Builder

In Interface Builder, you can interconnect objects in your application. For example, you
can establish the target and action for a control in the interface.

Interface Builder puts information about the classes used by your application in the nib file;
included are Application Kit classes and other classes provided by NeXTSTEP, as well as
the custom classes you define. The nib file contains all the information required to generate
the objects in your application at run time: specifications for objects, connections between
objects, icons, sounds, and other features. A NeXTSTEP application can have one or more
nib files for each application you create.

Add Other Resource Files

Resource files are frequently used to customize the user interface for your application.
Project Builder allows you to add icons for both your application and its documents.
Interface Builder allows you to add icons and sounds for the buttons in your user interface.
You can put other images in your application using Application Kit classes and PostScript
code. You can add other sounds using Sound Kit™ methods. Project Builder provides a
drag-and-drop interface for adding sounds, images, and other resource files to your project,
including unique icons for your application and its document files.
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Choose Document Extensions for Your Application

If your application reads and writes documents, you’ll need to take measures to see to it that
the Workspace Manager™ knows about and can work with those files. First, you need to
write file management code that saves the documents with a unique extension. You also
need to use the Project Builder application’s Attributes display to specify document
extensions for an application. Project Builder adds these extensions to the appropriate file
to assure that your application is invoked by Workspace Manager when the user
double-clicks a file with the specified extensions.

If you plan to distribute your software, or want to avoid future collisions with file extensions
used by other applications, register the document file extensions with the NeXT Extension
Registry. A list of currently registered names and the address for the extension registry is
included in the User Interface Guidelines.

Compile Your Program

As you add source files to your application, Project Builder lists them in the project
makefile. When you use its Build command, Project Builder starts the make program
which in turn reads the project makefile and generates the executable file from the sources.
As make runs, it issues system commands to compile and link your application’s source
files into an executable file. The project Makefile, generated by Project Builder, provides
the information make needs to do this job. The warnings generated by the compiler and
link editor provide information to help you locate and fix bugs detected at compile time.

In building your project, make keeps track of source updates. Each time you run make,
only the source files that have been updated since the last make are regenerated; the rest are
used as is. This minimizes the time required to generate your executable file.

Once you start building your application, Project Builder provides an interactive interface
to Edit for locating source code problems detected by the compiler and link editor. Anytime
the compiler encounters an error, Edit can locate the code with a single click—you can then
edit out the problem and begin compiling again.

Chapter 1: Putting Together a NeXTSTEP Application



Debug Your Program

After you successfully compile your program, you’re ready to try running it. The easiest
way to do so is by choosing Debug in the Project Builder application’s Builder display.
This selection builds your application (if necessary), then starts GDB in a Terminal shell.
You can then run your application with GDB in a couple of ways:

» Use Edit’s Gdb panel to step through your application while looking at the code being
executed. The Gdb panel provides an easy-to-use, interactive interface that integrates
GDB and Edit; it’s described in Chapter 2, “The Project Builder Application.”

* Run the program from the Terminal shell by issuing GDB commands. The GDB
debugger and its commands are described in Chapter 13, “The GNU Source-Level
Debugger.”

Along with the compiler and GDB, the NeXTSTEP development environment includes
several applications and features that can help you trace your program and pinpoint errors.
Other developer applications—including MallocDebug (Chapter 8), ProcessMonitor
(Chapter 9), and Yap (Chapter 10)—provide additional insights into the workings of your
program. ProcessMonitor lets you examine various characteristics of any process’s
activities: memory use, PostScript graphic states, the run-time environment, and so on.
MallocDebug measures the dynamic memory use of an application. Yap lets you enter,
edit, and execute PostScript code on the fly and allows you to read and write text files so
the code can be used elsewhere.

Two tools are available to track off-screen drawing, which may affect what you see—or
don’t see—on-screen. The NXShowPS argument writes all PostScript code and values
from the PostScript interpreter to the standard error stream. The NXShowAllWindows
argument displays all of an application’s windows, including those generated for off-screen
imaging. Both of these are command-line arguments. To use them, start your program
from a Terminal shell. On the command line, enter the program name followed by the
parameter. For example

/me/MyApps /NewApp/NewApp.app -NXShowAllWindows

starts the application NewApp.app, displaying all its windows as it runs.

The Application Development Process 1-7



1-8

Add Help to Your Application

Using Project Builder, Interface Builder, and Edit, you can create context sensitive help for
your application. The standard help template provided by Interface Builder includes
general information on the NeXTSTEP environment. You can add to this template to
include application-specific help, and you can create links between the controls in your
application and the help system to provide the user with context-specific assistance.

‘Translate Your User Interface

When the application is complete and help is available, you can create alternate versions
with translated text for windows, panels, menu items, and buttons, as well as any help
information you’ve added. NeXTSTEP application programming interface (API) provides
ways of accessing bundles in your application containing the text and user interface in
various languages you wish to support. “The Project Builder Application,” Chapter 2,
provides information on how to make a project localizable.

Make Your Application Available to Users

Once an application is debugged, you can install it in an application directory using Project
Builder. Project Builder lets you determine which directory to install the application in and
provides a way to automatically install the application when you build it.

When the user double-clicks a document file, the Workspace Manager has to locate and
start the executable file for that application. Workspace Manager looks for the executable
file in a systematic sequence of directory paths. This search sequence is contained in an
environmental variable path. You can place an application in any of the directories
specified in path.

Because of the search sequence specified by path, you can replace an application located
later in the sequence with one of the same name earlier in the sequence. For example,
$(HOME)/Apps occurs before /NextApps in path; if you place an application in the
directory $(HOME)/Apps with the same name as an application in the /NextApps
directory, the Workspace Manager finds and starts the version in $(HOME)/Apps (the
Apps subdirectory in your home directory). You should consider the path when naming and
installing applications.

If your application is intended for distribution on multiple floppy disks, you should
configure it so that a user can install it using the Installer application. Tools for doing so
are documented in /NextLibrary/Documentation/NextDev/Concepts/Installer.rtf.

Chapter 1: Putting Together a NeXTSTEP Application
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1%e Project Butlder Application

Project Builder is the hub of application development in NeXTSTEP. It manages the
components of your application and gives you access to the other development tools you
use to create and modify these components. Project Builder is involved in all stages of the
development process, from providing you with the basic building blocks for a new
application to installing the application when it’s finished.

Project Builder’s unit of organization is the project. A project can be defined in two ways:
conceptually and physically. Conceptually, a project comprises a number of source
components and is intended to produce a given end product, such as an application. (Other
types of end products are possible, as described below.) Physically, a project is a directory
containing source files and Project Builder’s controlling file, PB.project. This file records
the components of the project, the intended end product, and other information. For a file
to be part of a project, it must reside in the project directory and be recorded in the project’s
PB.project file. You don’t edit PB.project directly; your actions in the Project Builder
application—adding source files, modifying the project name or installation directory, and
so on—have the effect of updating this file.
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Project Builder can be used to create and maintain the following standard types of
NeXTSTEP projects:

Type of Project Description

application A stand-alone NeXTSTEP application, such as those found in
/NextApps or /LocalApps.
subproject A project within a project. With larger applications, it’s often

convenient to group components into subprojects, which can be
built independently from the main project. In building a project,
Project Builder builds the subprojects as needed and then uses
their end products—usually “.0” files—to build the main project.

bundle A directory containing resources that can be used by one or more
application. These resources might include such things as images,
sounds, character strings, nib files, or executable code. For more
information, see the class specification for the NXBundle class in
NeXTSTEP General Reference. A bundle can be a stand-alone
project, or contained within another project.

palette A loadable palette that can be added to Interface Builder’s Palettes
window. See “Adding Custom Palettes, Inspectors, and Editors”
in the next chapter for more information.

Project Builder also helps you prepare your application (or other type of project) for
various language markets, a process called “localization”. It does this by helping you
group language-dependent components of your application—TIFF and nib files, for
example—in subdirectories of the project. These subdirectories are named for a language
and have a “.lproj” extension (for example, Spanish.lproj), and so are commonly called
“Iproj” directories. Through the facilities of the NXBundle class, your application can
load the appropriate, language-dependent components depending on the user’s preferred
language. (See the NXBundle class specification in NeXTSTEP General Reference and
the file /NextLibrary/Documentation/NextDev/Concepts/Localization.rtfd for

more information.)

You can start Project Builder (located in /NextDeveloper/Apps) from the workspace as you
would any other application, by double-clicking its icon in the workspace. When it starts
up, only the main menu is visible. Once Project Builder is running, you can create a new
project or open an existing project as described below.
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Creating and Maintaining Projects in Project Builder

This section describes how to create a new project in Project Builder and how to convert a

pre-3.0 project to the 3.0 project format. You’ll also find information here about
maintaining your project.

Creating a New Project

To create a new project, choose the New command in the Project menu. A panel appears
in which you specify a pathname and name for the project. Specify a new directory on the
Name line, or choose an existing directory in the browser (and leave the name PB.project
in the Name field) if you want to use that directory as the root of the new project.

‘ New Project

Name:[MyApp I

" Project Typ

" Home - |‘

Cancel oo 0K |
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By default, the new project is a stand-alone application. A pop-up list in the panel lets you
create a bundle or a palette instead. No matter what type of project you create, a project
window for the new project appears.

_App — ~IProjects

[ Attriutes

CElClagees o

OtherResources -
Subprojects -

You’ll use this project window to maintain, build, and debug the project, as described in the
rest of this chapter. For now, note the three modes of operation indicated by the three
buttons in the upper right portion of the panel:

Mode Purpose

Attributes Set attributes of your project.
Files Add, remove, or open project files.
Builder Build the project.
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Opening an Existing Project

To open an existing project, choose the Open command in the Project menu. A standard
Open panel appears in which you specify the project to open. Select the file named
PB.project in the project directory and click Open to open the project.

When you open a project, its project window appears in Project Manager.

Opening and Converting a Pre-3.0 Project

To open an existing project that hasn’t been converted to the 3.0 project format, choose the
Open command in the Project menu. A standard Open panel appears in which you specify
the project to open. Select the file named IB.proj in the project directory and click Open
to open the project.

Convertmg IB prol

;

'HeIIoWnrld is an old style IB pro} Projec u!lder will
convert it into-a PB.project. In addition, it wil. -

overwrite Makefile, HelloWorld_main.m and .
Helloworld.iconheader; You may need to modrfy your:
‘Makef le. preamble and Makeﬁle postamble i les

i 3; Cancel 131 ~ No Backup l zBackup First <’3‘|

A panel appears warning you that the project file is an “old style IB.proj” which needs to
be converted to a PB.project. (Note: Be sure to convert the project if you’ll be continuing
to maintain it in Release 3.0.) Since the conversion process overwrite several project files,
you’re asked if you want to back up those files first before converting the project. Unless
you’re sure you don’t need to do this, you should click Backup First (or Cancel if you
decide not to continue)—this causes a copy of the entire project directory to be made, with
the name CopyOfProjectDirectory.

Once the project is converted, its project window appears in Project Manager. When you
save the resulting project, it will be saved as a PB.project file in the same directory. This
is the file you’ll open in the future when you work with the project.
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Setting Project Attributes

To bring up the Attributes display, click the Attributes button in the project window.
HX_Hello — ~/Projects

Y|

| Attributes

[s(HOMEYApps

"Dociiment Icons and Extensions

The contents of the Attributes display varies depending on the type of project—application,
bundle, or palette. The contents of these three types of Attributes display are shown below.

Application Attributes

If the project is an application, the Attributes display contains the following controls for
defining application attributes.

Applfcation i

yuage: [English |

all In:[$(HOME)/ Apps b

This group of controls includes fields for specifying the project name, the primary language
(that is, the language in which the project is being developed), and the target directory.
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=== Main File Info v
Generate Main File on Save'y] |

App. Class:| Application ||

_ App. nib File:| Application 1 |

This group of controls includes fields for specifying the application class and the
application’s main nib file, plus an option for regenerating the Main file whenever you save
the project. (Project Builder maintains this file and you aren’t expected to change it;
therefore you should leave this option checked, unless there’s a reason why you need to
maintain the Main file yourself)

Application lcon

The Application Icon well displays the application icon. The default application (shown
here) is used if you don’t provide one of your own choosing. To associate a new icon with
the application, drag its TIFF file from the workspace into the well. The file is copied to
the project directory, although it doesn’t appear in any of the categories shown in the

File display.

Document icons and Extensions

The Document Icons and Extensions well is where you indicate what types of documents
your application is able to deal with. If you’re creating your own document type, create a
document icon for it and drag the TIFF file containing that icon into the well. Once the icon
is in the well, change its label to match the document extension.
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System File’ Types
lie]  addresses ]

W,compressed z

System File Types lists NeXTSTEP file types (as identified by their standard NeXTSTEP
file extensions), any of which you may choose to have your application handle by selecting
the file type in the scrolling list. When you select a file type by clicking it, a check mark
appears next to its name, and it gets added to the Document Icons and Extensions well.
Click the file type again if you want to deselect it and remove it from the well.

Bundle Attributes

If the project is a bundle (or subproject), the Attributes display contains the following
controls for defining project attributes.

 ProjectType: [Bundis |

This pop-up list contains a Subproject item that lets you convert the bundle to a subproject.
Note, however, that this is possible only with a bundle that’s part of another project, not
with a stand-alone bundle.

Name |Bund|el f

Language IEngllsh §

AR

Th1s group of controls includes fields for changmg the project name and the primary
language.
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Palette Attributes

If the project is a palette, the Attributes display contains the following controls for defining
project attributes. '

Type:le‘:‘gl_eﬂt_tew —__— J
Name:| Palette 1 . ; |

Languege:English |

This group of controls includes fields for changing the project name and the primary
language.

Managing Project Files

The Files display of the project window is used to manage the files in the project. You can
use this display to add or delete project files, as well as open them for viewing or editing.

To bring up the Files display, click the Files button in the project window.

" NX_Hello — ~Projects

Files . Buider

Debug i Attributes

Encilizh lprol/HelloWarid nib
T

—_— o
v - }v :
o oW

H el S B K2 o B ]

5ot

The Files display provides a file viewer similar to the Workspace Manager’s File Viewer,
with categories of project components displayed in the left-hand column and project files
for each category displayed to the right. Note that these project categories don’t correspond
to project subdirectories—the categories are logical rather than physical groupings of files.
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The project directory provides you and Project Builder with a convenient way to organize
the files used in putting together your application. As shown here, files in the project
directory are grouped by Project Manager into a number of categories. These categories
are represented with a suitcase icon (and are frequently referred to as “suitcases”). Briefly,

these categories are:

Category
Classes

Headers

Other Sources

Interfaces

Images
Other Resources

Subprojects

Supporting Files

Libraries

Chapter 2: The Project Builder Application

Description

Files containing code for custom classes used by an
application.

Files containing declarations of methods and functions
used by an application

Files containing code (other than class code) for an
application. These may include “.m” files (containing
Objective C code), “.c” files (containing standard C code),
“.psw” files (containing PostScript code), and other
sources. Project Builder automatically adds the file
ApplicationName_main.m to Other Sources.

Nib files for each application and for each new module
added to an application. The flag icon next to a file name
in the Interfaces suitcase indicates that the file is
localizable (that is, the file is in the Language.lproj
subdirectory in the project directory, rather than in the
project directory itself).

Files containing images (other than icons) used by an
application, including TIFF or EPS files.

Files (such as sound files) for other resources used by an
application.

Directories containing subprojects used by an application

Files not used directly by the application but that should
be kept with the application.

Libraries referenced by an application. NeXTSTEP
libraries (including the default entries 1libNeXT_s and
libMedia_s) are referenced but not copied into the project
directory. Other libraries, such as those you create, may
be added to the project directory.



You can use Project Builder’s file viewer to:

Browse the project and the files it contains.
Add files to the project (as described below).

Remove files from the project by selecting the file in the browser and then choosing
Remove in the Files menu.

Open a project file by double-clicking its name or icon (or, selecting the file in the
browser and then choosing Open in Workspace in the Files menu).

There are in fact several ways to add an existing file to a project. The file can be already
located in the project directory, or it can be somewhere else. To add it, use one of the
following methods:

Drag the file from the File Viewer into the project window. If you drag it to the suitcase
it belongs in, that suitcase will open up. If you let it go, it will be added to that suitcase.
If instead you drag it to the project suitcase, the project suitcase will open up and the file
will be added to it. The Classes suitcase takes “.m” files, the Headers takes “.h” files,
and so on. “Other Sources” refers to files that are not headers or classes, but need to be
compiled and linked into the target of the project (application, bundle or palette). “Other
Resources” refers to files that need to be copied into the target. “Supporting Files” refers
to files that are necessary to maintain the project, but don’t end up in the target.

Select a suitcase and choose the Add command in the Files menu (or simply
double-click the suitcase). A panel will appear, in which you specify a file to add to the
selected suitcase.

Use the service that Project Builder supplies to other applications. Relevant applications
have a command named Project in their Services menu. This command brings up a
submenu containing two commands: Add To and Build. Add To can be used to add
the current file to the project (in this case, the file must already be located in the
project directory).

Also note the following shortcuts available in the File display:

Control-dragging in a file list allows you to reorder the files. This can be especially
important in dealing with libraries, since the file order determines the link order.

Alternate-double-clicking the icon of a selected file selects that file in the workspace File
Viewer, instead of opening it.

Command-double-clicking a source file opens both the file and its associated header file,
if it exists.
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Building the Project

When you instruct Project Builder to build the project, the project is compiled by the make
program using the project’s makefile. The project’s source files are compiled and linked
into an executable file. The project makefile provides the information make needs to do
this job. The warnings generated by the compiler and link editor provide information to
help you locate and fix bugs detected at compile time.

To build the project, first bring up the Builder display by clicking the Builder button in the
project window.

Attribu Files™

~ HelloWorld.app o

i Hﬁstl

R )

The Args field is for specifying build arguments to be passed to make; the Host field is for
specifying a remote host machine on which to build the project. Leave these fields blank if
you don’t have anything to specify. If you want to specify make arguments or a host name,
be sure to do so first before starting to build the project.

Note: If you build the project on a remote host, be sure you know what version of
NeXTSTEP the host is running.
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When you’re ready to build the project, click the Build button. As the build progresses, the
two views at the bottom of the window inform you of any warnings or error messages that
occur—the upper Summary view is more selective in what it chooses to display, so you may
choose to hide the lower Detail view and only refer to its output when you need to.

NX_Hello — ~/Projects

o Word: | )

i Run - Debug Attributes Files Builder
_3'____ HelloWorld.app — Build failed {Ulm
. ‘& args:| | Host L \ -
[ Wortd View.h ‘
~.| Iegal declaration: missing *;" after ‘dravHello” ;;
| World View.m i

~]_illegal statement: missing *;” after ]

2| inegal keyword selector: missing ‘identifier’ after

’E] WorldView.h:52: illegal declaration, missing ;" after ‘drawHello”
~WorldView.m:69: illegal statement, missing ;" after ‘|’

2 Worldview.m:74: illegal keyword selector, missing ‘identifier’ after «:”
FY MRS

_A’Stnn _

«

If an error is encountered during the build process, a message appears in both the Summary
view and the Detail view, as shown here. Click a line in the Summary view to open the
specified file; if you click a line containing an error message (shown in red on color displays
and bold on monochrome displays), the file opens in Edit and scrolls to display the line that
contains the error.

Build Targets
app.make (the shared makefile used to generate the executable file for all applications
created with Project Builder) defines a number of alternate targets to perform specific tasks

at various phases of the application development process. To run make using the alternate
targets, enter the corresponding argument in the Args text field of the Builder display.
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The following table lists various targets and the tasks they perform.

Target
none

debug

clean

install

installsrc

depend

profile

help

Task

If no target is specified, compiles and links a debuggable, optimized
version of the executable file. This is the default target used when you
give the Build command without an argument.

Compiles (with all warnings and -DDEBUG on) and links a
debuggable, unoptimized version of the executable file with the
extension “.debug”.

Removes all derived files, such as object and executable files, from the
project directory, returning the project to its precompiled state.

Builds (if needed) and copies the application into the installation
directory specified in Project Builder, setting permissions and owners
as appropriate. The default is S(HOME)/Apps, the Apps directory in
the user’s home directory.

Installs the source files for the project into the directory specified in the
SRCROOT variable in a command-line argument (you must specify
the target directory on the command line). If the directory exists it
(and its contents) will be deleted, and then be recreated before the

“source files are moved there. This option is useful for archiving

completed projects.

Generates an optional Makefile.dependencies file, containing a
complete dependency graph for the project, including headers. Once
this file exists in the project directory, it’s conditionally included by
your project makefile.

Generates (with all warnings and -DPROFILE on) the file
ApplicationName.profile, an executable containing code to generate a
gprof report. This option is useful when you are performance tuning
an application. See the UNIX manual page gprof for details on
profiling.

Lists these targets with their parameters.
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The Preamble File

Sometimes it’s necessary to alter the standard build process as defined by the project
makefile. You do this by adding to the project a Makefile.preamble file that overrides the
macros defined in the project makefile. To override a macro definition in the project
makefile, include a definition for the same macro in Makefile.preamble. For example, the
following definition for the macro INSTALLDIR always appears in the project makefile:

INSTALLDIR = $(HOME)/Apps

This macro causes the make install target to place the executable in the Apps subdirectory
of your home directory. To have install place the executable in another directory, define the
following macro in Makefile.preamble:

INSTALLDIR = /LocalApps

To use one of the macros listed above in app.make, you first define it in
Makefile.preamble. You can, for example, define link editor flags to add segments to your
executable file. For example, an application might defines the following macro in its
Makefile.preamble:

LDFLAGS = -segcreate EXTRA document extra.rtf

Using this macro definition, the link editor will create a segment named “EXTRA” in the
executable file; that segment will have a section named “document” containing the
document file extra.rtf.

See the makefiles in /NextDeveloper/Makefiles for more information.

Setting Preferences

You can specify preferences for a variety of options using the Preferences panel. To bring
up the panel, choose the Preferences command in the Info menu.

Enter values or click buttons to specify new preferences, as described below. Then click
Set to set the new preferences (or click Revert to restore the previous settings). Note that
the settings on the Preferences panel are global—they apply to all projects, not just the
current project.
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The controls in the Bulld Defaults group let you specify build arguments to be passed to
make, a remote host on which to build the project, and an alternative to /bin/make, the
standard make program.

The controls in the Build Service group let you specify what (if anything) you want to have
happen after building your project (specifically, after building your project by choosing
Project Builder’s Build command on the Services menu)—Build only, Build and Run, or
Build and Debug.

Save Optluns '
e .ﬁsuto save__] ‘
i V‘_Delete Backup Flle__] |

The controls in the Save Options group let you specify whether projects should be
auto-saved, and whether the most recent backup file is automatically deleted or retained.
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Running and Debugging an Application

In addition to maintaining and building a project, you can use Project Builder to run or
debug the resulting application, as described in this section.

Running

To run the project application, click the Run button in the project window. If the project
hasn’t been built yet, it’s built and then the application is run. The Run button’s icon is the
same as the application icon—the icon shown here is the default application icon that’s used
if no other icon is specified in the Attributes display.

Tip: Alternate-clicking the Run button runs the application without building it first.

Debugging

To debug the project application, click the Debug button in the project window. If the
project hasn’t been built yet, it’s built first and then the application is run in debug mode.

Tip: Alternate-clicking the Debug button runs the application under the debugger without
building it first.
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When you indicate that you want to debug an application in Project Builder, the following

steps occur:

* The project is built (unless it’s already up to date).

* Terminal creates a new window to run the GDB process in.

* As GDB starts, it’s instructed to read the PB.gdbinit file in the project directory.

¢ The view command in the PB.gdbinit file is executed and causes a command named
Gdb to appear in Edit’s main menu.

Choose the Gdb command from Edit’s main menu to display the GDB control panel.
This panel has the application name as its title, and contains four groups of controls for
interacting with GDB as you debug the application. (GDB commands that aren’t
accessible through the panel can still be executed manually in the shell window in which

GDB is running.)

The first group (labeled either Running or Stopped) contains the following buttons for
controlling the execution of the application.

Button
Run

Continue

Finish

Quit
Step

Next

Description
Starts the application being debugged.

Continues the application being debugged, after a signal or
breakpoint.

Executes until the selected stack frame returns. (Upon return, the
returned value is printed and put in the value history.)

Exits GDB.
Steps the application until it reaches a different source line.

Steps the application, proceeding through subroutine calls. The Next
command is like the Step command as long as there are no subroutine
calls; if there are, the call is treated as one instruction.
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. Break At | Run | hfii'I

The Line group contains controls for setting breakpoints in source files and running until a
breakpoint is reached. These controls use Edit’s current file and line as their argument.
Click the Break At button to set a breakpoint at the line containing the insertion point in the
main Edit window. Click the Run Until button to run the application until it reaches the
next breakpoint.

Selection

- Print l Print *

The Selection group contains controls for evaluating and printing the value of a C or
Objective C expression. These controls use Edit’s current selection as their argument.
Click the Print button to display the value of the selected expression. Click the Print*
button to display the value that the expression points to.

3 Browse <"”50

The Stack group contains controls for browsing the data in the program being debugged.
Clicking the Browse button causes the following browser panel to appear:

Application run)
XGetOrPeekEvent
DPSGetOrPeekEvent
sg_recelve
sg_receive_frap

You can use this browser to select and inspect particular stack frames and their variables.
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Project Builder’s main menu contains the standard Info, Edit, Windows, Services, Hide,
and Quit commands. All commands unique to Project Builder are located in the Project
and Files submenus—these menus and the commands they contain are described below.

Commands in the Project NMenu

The Project menu contains commands for creating and maintaining your projects.

Command
New

Open
Open Makefile

Save

New Subproject

Add Help Directory

Chapter 2: The Project Builder Application

Description
Creates a new project.

Opens an existing project.

Opens a window for just the Makefile of a project and
displays the Builder view in the window. To build the
project, click Build.

Saves the current project.

Creates a new subproject. A panel appears in which you
specify the name and type of subproject. The type can be
either Subproject or Bundle.

Subproject
ndie”

Specify a name and type, and then click OK to add the
subproject or bundle to the current project.

Adds a Help directory to the current project. A template
Table of Contents file and Index file are placed in the Help
directory. For more information on adding help to an
application, see Chapter 3.



Run Application

Debug Application

Build Application

Runs the application associated with the project, just as if
you had clicked the Run button in the project window.

Debugs the application associated with the project, just as
if you had clicked the Debug button in the project window.

Builds the application associated with the project, just as
if you had clicked the Build button in the project window.

Commands in the Files NMenu

The Files menu contains commands that affect the files that make up a particular project.
Commands in this menu are enabled only when the Files view for the project is selected.

Command
Add

Open in Workspace

Select in Workspace

Remove

Sort

Make Global

Make Localizable

Description

Adds a file to the selected suitcase in the current project.
Be sure to select the appropriate suitcase in the File view
before choosing the command.

Opens the selected file in the application that’s registered
with the Workspace Manager as the default application for
files of that type.

Displays and highlights the selected file in the Workspace
Manager’s File Viewer window.

Removes the selected file from the current project
(without deleting it from the project directory).

Alphabetically sorts the files in the current suitcase.

Makes the selected file global (that is, moves it from the
Language.lproj directory into the project directory).

Makes the selected file localizable (that is, moves it from
the project directory into the Language.lproj directory).
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1%e Interface Builder
Application

Interface Builder is a tool that helps you design and build applications. It speeds the
creation of applications by letting you define an interface (and in some cases, an entire
application) graphically rather than by writing C and Objective C code. With Interface
Builder, you drag objects from palettes of NeXTSTEP objects directly into the application
you’re building. Once there, an object can be modified in ways that are specific to its class:
You can set a Button object’s title or set the minimum and maximum values of a Slider
object, for example. After you’ve gathered and edited the objects that will make up your
application, Interface Builder lets you define the interactions among them and associate
help messages with each of them. Even before you write a line of code, you can run your
application within Interface Builder to check the operation of its interface.

Interface Builder’s technique of direct manipulation of programming objects isn’t limited
to objects defined in NeXTSTEP. Interface Builder’s palettes are extensible, letting you
load palettes containing objects that you or other developers have created.

In many ways, using Interface Builder to create an application is much like using a graphics
editor to create a drawing. However, Interface Builder is not a simple “screen painter” or
form-generation tool. When you build an application with Interface Builder, you are
interacting with the actual programming code that will be executed when your application
runs on its own. The objects you manipulate in Interface Builder are the objects that will
appear in the working version of your application. If your application runs correctly in
Interface Builder, it will run correctly on its own.
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The work you do in Interface Builder is saved in a nib file (a file package having a name
ending in “.nib”, which stands for “NeXTSTEP Interface Builder”). This file contains
archived versions of the objects you assembled for your application, information about
connections between these objects, and other information. When an application begins
running, it unarchives these objects and associated information from one or more nib files.
Nib files are discussed in more detail late in this chapter, but for now it’s important to note
that projects in NeXTSTEP contain at least one nib file and that Interface Builder lets you
create and modify these nib files.

As pointed out in the previous two chapters, the central tool for developing applications in
NeXTSTEP is Project Builder. When you start a new project in Project Builder, you're
provided with several standard components, one being a nib file. When you want to modify
this standard nib file, Project Builder invokes Interface Builder as the nib file’s editor.
Interface Builder and Project Builder are interlinked in other ways as well. As you define
new classes, import images or sounds, or create new nib files, Interface Builder and Project
Builder work together to keep each other aware of the state of the project.

Even if you’re new to this computing environment, you’ll find that with Project Builder and
Interface Builder, you’ll be able to create applications with a minimum of time and effort.
This efficiency results from working directly with the application’s objects, rather than with
files of programming code. However, the more you know about the Application Kit and the
more comfortable you are with programming in the Objective C language, the easier
application development will be for you. Thus, we recommend that you familiarize
yourself with the material in NeXTSTEP Object-Oriented Programming and the Objective
C Language and at least scan the class specifications (located in Chapter 2 of the
NeXTSTEP General Reference manual) for the major Application Kit classes before
attempting to take your work with these tools beyond the experimental stage.

This chapter provides general reference information on Interface Builder. It first introduces
Interface Builder’s major components and then discusses some of the common tasks that
you use Interface Builder to accomplish. A final section provides a quick reference for each
of Interface Builder’s commands.

For a tutorial-based introduction to this tool—and to programming in NeXTSTEP in
general—see Chapters 15 through 18 of this manual. Interface Builder’s application
programming interface (API), which allows you to create custom palettes, is described in
detail in Chapter 8 of the NeXTSTEP General Reference manual.
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The Basics

An Orientation

When you use Interface Builder, its windows—and the windows of the application under
construction—share the screen. The illustration gives you an idea how this looks.

Main menu Palettes window
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Interface Builder’s windows frame an area of the workspace where you build your
application. At the upper left is the main menu, which gives you access to Interface
Builder’s tools and commands, and at the upper right is the Palettes window. The Palettes
window is the source of objects (Buttons, Sliders, Windows, and so on) that you can drag
into your application. Below the Palettes window is the Inspector window. You use this
window to set the attributes of an object, to connect it to other objects, and to review the
attachments between objects and help messages. At the bottom left is the File window.
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The File window displays your application’s top-level objects (its windows, main menu,
and so on) and gives you access to the image, sound, and class resources that are available
to your application.

Building an Application with Interface Builder

The Application Kit defines a library of user-interface objects that you can select from
for your application. Interface Builder makes the selection process a graphical one:

You simply drag the object you need from the Palettes window into the application
you’re building. By building an application in this way, you can be sure that its interface
will work properly and will, in a broad sense, conform to the interface standards for
NeXTSTEP applications.

(Other NeXTSTEP software kits, such as the Database Kit™, can supply user interface
objects in the form of Interface Builder palette objects. This discussion applies to those as
well, but for simplicity this discussion focuses on the Application Kit since it provides the
preponderance of user-interface objects.)

Once an object is added to your application, you can adjust the values of many of its
instance variables directly. For example, to change the size of a button, you drag one or
more of its sides to a new position. Changing the image on the screen changes the value of
the Button object’s frame instance variable. For attributes that aren’t easily represented
graphically, Interface Builder provides the Inspector window that lets you set the values for
particular instance variables. You set the maximum and minimum values of a slider with
the Slider Inspector, for example.

Interface Builder also lets you interconnect objects so that they can communicate with one
another. For example, a button can be connected to the window it appears in so that when
the button is clicked, the window closes. Such connections are made through an object’s
outlets. An outlet is an instance variable that identifies another object in the application.
Common examples of outlets include a Control’s target or an Application or Window
object’s delegate.

The objects in the Application Kit are general-purpose and fill the needs of a wide
cross-section of applications. What makes your application unique is the code you write.
For example, the Application Kit provides the Buttons and other Views you need to
implement an interface for a calculator, but you have to create the computational engine.
Interface Builder helps you declare classes that encapsulate the code that’s unique to
your application.
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Interface Builder and the Objective C language encourage a style of programming that puts
your application’s unique code in one or more objects of your own design. The
application’s user-interface objects handle routine business, such as displaying the main
menu or hiding the application, and also serve to interpret the user’s actions for the objects
you design. If the user clicks the calculator’s Add button, the Application Kit highlights
the button and then sends a message to your calculator object to perform the addition.

Using this style of programming, your application will generally contain a number of
standard Application Kit objects and one or more subclasses of Object and View. Most
often, the subclasses of Object embody the logic that’s unique to your application, and the
View subclasses contain the drawing code that’s unique to your application. You’ll rarely
need to create subclasses of other Application Kit classes.

The Nib File

The work you do in Interface Builder is saved in a nib file—actually, a file package whose
name ends in “.nib”. This file contains:

* Archived objects. The Buttons, NXBrowsers, TextFields, and other objects that you
dragged into your application’s windows while designing your application’s
user-interface are archived in the nib file. The archived information includes the object’s
class and other attributes, such as its size, location, and position in the view hierarchy
(for View objects).

» C(lass interface information for any subclasses that you define. At run time, the
Application Kit sends messages to create objects of these classes.

* Information about how outlets should be initialized at run time.

* Information about action messages and their targets.

* Sound and icon data.

* Areference to an owner object. (The nib file’s owner is described in the next section.)

NeXTSTEP applications have at least one nib file, the main nib file. This file contains the
specifications for the application’s main menu and perhaps other objects. An application
can have only one main nib file.

More complex applications may have other nib files in addition to the main nib file. For
example, an application might have two nib files, one containing the archive for the main
menu and other primary interface objects and the other containing an archive for a Find
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panel. If a user issues a search command, the Find panel is created by loading the objects
from the secondary nib file. Since the Find panel isn’t created unless it’s needed, the Find
panel’s objects don’t consume system memory or add to the application’s start-up time.

Interface Builder’s File window gives you a summary view of the contents of a nib file.
Each window in the nib file is represented by a window icon in the File window. By
double-clicking a window icon, you can bring the window it represents to the front so
that the objects it contains are visible. The File window also contains icons that represent
the file’s owner object and a “First Responder” object, objects that are discussed in the
next sections.

The Nib File's Owner

The nib file’s owner is an object that’s external to the nib file and that is the conduit for
messages between the objects that will be unarchived from the nib file at run time and the
other objects in your application. In general, the core objects in your application access the
objects unarchived from the nib file indirectly through owner object. In turn, the
unarchived objects communicate with the other objects in your application by sending
messages to the owner object.

Each nib file has one—and only one—owner. For small applications, the owner is
generally NXApp, the Application object itself, although it can be an object of any class.
The owner is the only external object that may be the explicit target of action messages from
Controls within the nib file. The owner may also have outlets that will be initialized at run
time to point to the objects within the nib file.

The owner must exist before the interface objects are loaded. For example, Project Builder
generates a main file that follows this sequence of messaging to create the owner, load the
interface information, and then run:

[Application new];
if ([NXApp loadNibSection:"HelloWorld.nib" owner:NXApp withNames:NO])
[NXApp run];

Note: NXApp is a global variable that identifies the Application object, the object that’s
created by the message in the first line of the example above. (For more information on the
loadNibSection:owner:withNames: method—and especially on the search path it uses
for locating the appropriate nib file to load—see the specification for the Application class.)

‘What happens when the nib file is loaded at run time is described in “The Nib File at Run
Time,” later in this chapter.
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The First Responder Object

The First Responder icon in the File window represents the object within a window that will
be the first to receive keyboard events, mouse-moved events, and action messages from
Controls that don’t have an explicit target.

In most cases, a window’s first responder will be chosen from the window’s Text objects
(or objects that use Text objects such as Form, TextField, and ScrollView objects). Clicking
one of these objects generally makes it that window’s first responder. Over time, many
different objects can become the first responder, but at any one time, only one object has
this status. The First Responder icon stands for the object that has this status, no matter
which actual object it is within your application. In this respect, the First Responder icon
is really a fiction since it identifies no one particular object, but rather any object having a
particular status. This fiction, however, is very useful.

Having First Responder in the File window lets you connect an object, such as the
MenuCell that sends the copy: message, so that it sends its action message to a target whose
identity changes over time. Thus, for example, the Copy command can be set up to work
with any TextField in a window, as long as the TextField is the first responder. If you create
a new application in Project Builder, open its nib file, and check the connections in the
application’s Edit menu, you’ll discover that all Edit commands are connected to the
First Responder.

(Incidentally, the ability to let the target of a message be defined at run time rather than
at compile time is an example of dynamic binding in Objective C. For more information
on Objective C, see NeXTSTEP Object-Oriented Programming and the Objective C
Language.)

The Nib File at Run Time

As pointed out previously, the standard main file generated by Project Builder includes
these messages:

[Application new];
if ([NXApp loadNibSection:"HelloWorld.nib" owner:NXApp withNames:NOJ)
[(NXApp runl;

The loadNibSection:owner:withNames: messages invokes code within the Application
Kit that unarchives the nib file’s objects, instantiates custom objects, establishes
connections between objects, and finally informs these new objects that they have been
loaded. The following sections describe these steps in more detail.
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Step 1: Unarchiving Objects

The first step the system takes in loading a nib file is to unarchive the objects it contains.
An object archive records the class and salient data structure of a particular object. To
unarchive an object, the system allocates memory for the object (by sending the class object
an alloc message) and then sends the newly allocated object a read: message to read in the
applicable data that was preserved in the nib file. For example, to unarchive a Button
object, a new Button object is allocated and then sent a read: message to read information
such as its title, size, identity of its superview, and so on from the nib file. As part of the
unarchiving system, all objects receive an awake message after they have been unarchived.
(See the Object class specification in the NeXTSTEP General Reference manual for more
information on archiving.)

Step 2: Instantiating Custom Objects

A nib file can also contain references to objects that you have defined. (See “Defining New
Classes” later in this chapter for more information.) For example, you could use the Classes
display of the File window to define a subclass of Button called RepeatButton.
(Presumably, when pressed, a RepeatButton sends its action message repeatedly at a given
interval.) To add a RepeatButton to your application, you drag a CustomView object into
your application’s window, set its size and location, and reassign its class to be
RepeatButton. When you save the nib file, Interface Builder records that an object of the
RepeatButton class is of a certain size and location within your application’s window. The
object itself isn’t archived since the code for the class isn’t accessible to Interface Builder;
in fact it may not yet exist!

As the nib file is loaded at run time, the system will attempt to instantiate this RepeatButton
object. Assuming you have linked the code for the RepeatButton class into your
application, the RepeatButton class object will receive an alloc message and then an
initFrame: message, and the object will be instantiated.

The initFrame: message is used only for custom objects that inherit from View. For
non-View objects, an init message is sent instead. (Custom objects that don’t inherit from
View are represented by a sphere icon in the File window.)

Note the distinction between the messages a custom object receives and the messages an
archived object receives. When a nib file is loaded, a custom object receives an init...
message but not a read: or awake message. Conversely, an unarchived object receives
read: and awake messages but not an init... message. (However, objects of both types can
receive awakeFromNib messages, as described later in this chapter.)
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This distinction becomes important when you create custom palettes for objects that you
have defined. (The section “Setting Preferences” discusses custom palettes.) For example,
using a CustomView, you might add a RepeatButton to an application and find that the
application operates properly when executed. Then, you might create a custom palette
containing a RepeatButton object. An application built using a RepeatButton from this
custom palette may not operate properly unless a RepeatButton’s unarchiving methods can
establish its state as completely as its init... method does.

Step 3: Establishing Connections

As the next step in loading the nib file, code in the Application Kit establishes connections
between the objects that were created in the previous steps.

You make connections between objects in Interface Builder using the Connections
inspector. (Connections are described in more detail in “Setting Connections” later in this
chapter.) When you establish a connection, you identify a source object, an outlet of that
object, and a destination object. For example, the source could be a Window object, the
outlet could be the Window’s delegate instance variable, and the destination object could
be a custom object. By establishing this connection, you are specifying that, at run time,
the custom object will be the Window’s delegate, and thus capable of receiving any of the
messages that a Window sends to its delegate. (As described later, some connections are
more constrained in that they specify not only an outlet and a destination object, but a
specific message to be sent to that object.)

After the nib file’s archived objects are unarchived and its custom objects instantiated, the
connections that were established in Interface Builder are reestablished with these run-time
objects. Using the example above, the Window is unarchived, the custom object
instantiated, and then the Window’s delegate outlet is set to the id of the custom object.

Connections to and from the file’s owner object are also established at this time. This is
possible since the method that loads the nib file takes as one of its arguments the id of the
file’s owner:

[NXApp loadNibSection:"HelloWorld.nib" owner:NXApp withNames:NO]

Connections between objects are established in one of two ways. If the source object
responds to a setMyQutlet: message, it will be sent that message. So, using the example
above, the Window object would receive a setDelegate: message. (Note that the system
determines the message to send by capitalizing the first letter of the outlet’s name and
prepending “set”.) If the object doesn’t respond to such a message, the value of its outlet
instance variable is set directly, without a message being sent. Thus, you don’t have to
implement a setMyQutlet: method for each outlet you declare for a custom object.
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Step 4: Sending awakeFromNib Messages

As the last step in loading the nib file, the system sends awakeFromNib messages to the
objects that were derived from the information in nib file. Any object that was created from
the nib file can receive this message if it implements the corresponding method.

The awakeFromNib message signals that the loading process is complete. It’s guaranteed
that when an object receives an awakeFromNib message, all of the nib file’s archived
objects have been unarchived, all of its custom objects instantiated, and all connections
recorded in the nib file established.
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Manipulating View Objects

In general, in Interface Builder you interact with View objects through direct mouse
manipulation. To select an object in your application’s window, click it. An object
indicates that it’s selected by displaying eight small squares—or control points—around its
perimeter. You can select multiple objects by holding down the Shift key while clicking
each one in turn. You can also select multiple objects in a window by “rubberbanding”
them. That is, you position the cursor to one side of the objects, press the mouse button,
and drag diagonally across the objects. Your motion with the mouse describes a rectangular
area marked with a fine, dotted outline. When you release the mouse, any object contained
in the area, or intersected by the outline, becomes selected.

Once an object is selected, you can resize it by dragging one of its control points. To
reposition the object, drag anywhere within the object, but not on one of the control points.

Double-clicking an object selects some feature within it. For example, single-clicking
a button selects it, but double-clicking the button moves the focus of selection to the
button’s title.

For more complex Views, double-clicking lets you move the focus of selection down the
view hierarchy. For example, if you double-click a Box object that contains Button
subviews, the focus of selection moves to the Button objects. Now that the focus in within
the Box, double-clicking one of the Buttons selects the text within it.
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The mouse can also be used to resize the document view of a ScrollView. Imagine that you
have selected one or more objects in a window and then issued the Group in ScrollView
command. To manipulate these newly grouped objects, you double-click within the area of
the ScrollView. Now, if you move the cursor to the top or right edge of the ScrollView, the
cursor changes to a double headed arrow indicating that you can resize the ScrollView’s
document view. By pressing the mouse button and dragging away from the center of the
ScrollView, you simultaneously increase the size of the document view and scroll the
ScrollView to make the new portion of the document view visible. Scroll buttons and a
scroll knob appear to indicate that the document view exceeds the dimensions of the
ScrollView. Using this technique, you can specify which portion of the ScrollView will be
visible at run time.

Using the Layout Commands

The commands in the Layout menu help you arrange objects in a window. You’ll find it
easiest to learn their operation through experimentation. For example, add two buttons to
an application window, select both, and then experiment with the Layout commands. See
the command descriptions at the end of this chapter for more information.

Using the Alignment Panel

This panel lets you set the spacing of the alignment grid, the grid that help you position
objects accurately within a window. It also lets you set the reference point by which objects
are aligned to the grid.
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- Align
() Left edges /Bottom
" Centers ‘

»Rightedges / Top edg

edge
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The three radio buttons let you set whether an object’s lower left corner, center, or upper
right corner are constrained to an intersection of the grid. The grid size field displays the
value used for the vertical and horizontal spacing of the grid. You can adjust this value
either by the slider or by entering a value in the grid size field. The value must be an integer
in the range from 4 to 32. The area above the slider displays the current setting of the
grid spacing.

Tip: Although in general it’s best to leave the grid on and align your interface objects to it,
at times, you may want to position an object off the grid for aesthetic reasons. To do this,
turn the grid off, position the object, and then turn the grid back on. Interface Builder will
leave the object where you put it despite the grid setting, as long as you don’t try to move
the object when the grid is on.

Inspecting Objects

You use the Inspector panel to edit the properties of both View and non-View objects in
your application. The Inspector panel appears when you click the Inspector command in
Interface Builder’s Tools menu.

The panel has many personalities. Its contents are determined by Interface Builder’s
selection: If a Button object is selected, the Inspector panel displays the Button Inspector;
if a Window is selected, the panel displays the Window inspector. (The Inspector

panel’s title announces the class of the selected object.) In addition, the panel itself has
four displays—Attributes, Connections, Size, and Help—which are accessible through
the pop-up list at the top of the panel. These four displays are discussed in the following
sections.

Setting Attributes

The Attributes display of the Inspector panel lets you set the selected object’s basic
characteristics. For example, the illustration shows the Attributes display of the
Button Inspector.
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Conceptually, each of the characteristics in the Attributes display corresponds to an
Objective C message that the selected object responds to. For example, this table shows the
correspondence between some of the attributes displayed in the illustration above and
messages that a Button object understands:

Attribute Message

Title setTitle:

Alt. Title setAltTitle:
Icon setlmage:
Sound setSound:

Icon Position setIconPosition:

If you have questions about any of the attributes displayed for a selected object, you should
consult the class specification (in NeXTSTEP General Reference) for that object.

The Attributes display for the File’s Owner, for CustomViews, and for custom objects that
you instantiate in the File window lets you set the class of these objects.
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The Attributes display for images in the File window’s Images suitcase shows the image
and its dimensions. This display doesn’t allow you to edit the image or the dimensions. It’s
primarily used to examine bitmaps that are too large to be displayed in the Images display
of the File window.

If you select a sound icon in the Sounds display of the File window, the Inspector panel
displays the Sound inspector. This inspector lets you display, record, play, and make
limited modifications to sounds. The inspector is divided into three areas. The top portion
shows a graphical representation of the sound’s waveform. The middle portion displays a
horizontal sound meter much like one found on a stereo amplifier. The bottom contains a
series of buttons that control the recording and playback of sounds. To play the entire sound
depicted by the waveform, click Play. To play a portion of the sound, select some portion
of the sound’s waveform and click Play. The standard editing commands, Cut, Copy, and
Paste, operate on the selected portion of the waveform—for editable sounds. The Record
button starts recording through the microphone. If a segment of the waveform is selected
when you click Record, the new recording replaces the part of the current recording
represented by the selected segment. If a point on the waveform is selected when you click
Record, the new recording is inserted at that location in the current recording. The Pause
button halts the recording you’re currently creating or playing back. (The bars on the button
are highlighted during a pause.) Press Pause again to restart at the point where you paused.
The Stop button stops the recording you’re currently creating or playing back.

Setting Connections

The Connections display of the Inspector panel lets you establish and review
connections between objects. You create a connection by Control-dragging a line
from the source object to the destination object. When the destination has been
unambiguously identified, Interface Builder draws a rectangle around it. Releasing
the mouse button completes the operation. If the Inspector panel isn’t already open,
it opens and shows the Connections display.
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Note: The rectangle that appears around the destination object is black if the destination
object is discrete (such as a single slider or button) and gray if it’s a matrix of objects. For
example, if you Control-drag a connection toward a Matrix of ButtonCells, a gray rectangle
appears around the group of objects when the cursor first intersects the perimeter of the
Matrix. As you continue dragging into the Matrix the gray rectangle disappears to be
replaced by a black rectangle around the ButtonCell that the cursor is within. Thus,
Interface Builder lets you connect to the member or the group. Remember that a Form
(being a subclass of Matrix) is a matrix even if it has only one FormCell.

The left column of the display lists the outlets of the source. If the outlet is named “target”
(in other words, the source object is a Control) the right column lists the action messages
that the destination object can respond to. By selecting an outlet in the left column and, for
sources that are Controls, selecting an action message in the right column and clicking the
Connect button, you establish a connection between the source and destination objects.
That connection is listed in the lower portion of the panel.

Tip: By clicking the entry in the Connections list, you can have Interface Builder display
the connection line between the source and destination objects.

After you click the Connect button, the button’s title changes to Disconnect, allowing you

to remove the connection. If you cut or copy a connected object and then paste it, its
connections are severed.
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Setting Size Characteristics

The Size display lets you set the precise dimensions and location of the selected object and
specify how the object will respond to resizing..

The Frame fields let you set the object’s location, width, and height. Normally, you set
these attributes through direct mouse manipulation of the object. These fields are provided
for those situations in which more precision is required.

The Autosizing portion of the display presents a schematic of the selected object and its
surroundings. The small square represents the selected object and the area around it
represents its superview or other surroundings. (If the selected object is a window, the
small square is replaced with a window image.) The horizontal and vertical lines that bisect
the squares are the controls that let you set resizing behavior.

Clicking the horizontal line inside the small square changes the line to a spring shape,
indicating that when the superview or window is resized horizontally, the object will also
resize to maintain its distance from the left and right margins. In the same way, clicking
the vertical line within the object causes the object to become vertically resizable.

The lines outside the object represent the constraints on the object’s distance from the top,
bottom, left, and right edges of its superview. A straight line indicates that this dimension
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will remain fixed, if at all possible. A spring shape means that this dimension is resizable.
Clicking toggles the image from line to spring shape.

You can create an impossible resizing relationship, such as specifying as fixed the object’s
dimensions and its distance from the window’s edges. In cases of conflict, an object’s fixed
dimension is given precedence over its fixed distance from a border. If all dimensions are
made resizable, changes to the window or superview’s dimensions are shared by the object
and its distance from a border.

Reviewing Help Attachments

The Help dlsplay lets you review attachments between objects in your application and help
text. It also gives you access to Interface Builder’s Help Builder panel.

MainMenu - ChooseCommal;
Edit(Menu ltem) DetachSubmen|

Marker
File: Tasks{GettmgStarted/Cho

;"Help Builder.. | { Detach

The Help display is used in conjunction with the Help Builder panel. See “Attaching
Help to Objects” later in this chapter for information on associating help text with objects
in your application.

Assuming you have attached help to objects in your application, the Help display of the
Inspector panel will list those attachments. Each entry in the list has two parts. The left
half of the entry identifies the object, and the right half displays the file name for the
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attached help. Below the Help Attachments list are two text fields. The Marker field names
the marker that the object is attached to within the help file. If the object isn’t attached to
any marker in the file, the Marker field is blank. The File field displays the path of the help
file relative to the application’s Help directory. If the entire path isn’t visible, scroll the text
field horizontally to reveal the hidden portion.

You can remove an attachment by selecting it in the list and clicking the Detach button.

Defining New Classes

The Classes display of the File window shows the classes that are available to your
application. It also lets you define new classes. You open this display by clicking the
Classes suitcase in the File window.

Objects
o:[Object

Each class is displayed in proper relationship to the other classes: A class’s superclass is
displayed to its left and its subclass is displayed to its right. NeXTSTEP classes are
displayed in gray, indicating that they can’t be edited. The classes you define, being
editable, are displayed in black. The Find field helps you locate classes in the hierarchy.
Simply enter a class name and press Return. The browser will scroll to the class and
select it.

You can add classes to this hierarchy in two ways:

* Drag the icon for a class interface file from the Workspace Manager File Viewer to the
File window. When you do, the Classes resource icon in the File window opens to
accept the interface definition. Interface Builder parses the interface file and places the
new class in its proper place in the class hierarchy.
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Warning:

* Drag to the Subclass button in the pull-down list as described in the next section.

The pull-down list in the Classes display lets you operate on new or existing classes. The
commands are described in the following sections.

‘Subclass

This button creates a new class as the subclass of the class that’s currently selected in the
browser. New classes are named MySuperClassName. The Class Inspector panel opens
when you create a subclass allowing you to rename the class and edit its outlets and actions.

This button creates an object of the selected class and places an icon representing that
object in the File window. The object’s name refers to its class. For example, if you define
the Gauge class and then choose Instantiate, the object that appears in the File window is
named Gauge. If you instantiate additional Gauge objects, they’ll be named Gaugel,
Gauge2, and so on.

Tip: Although you can instantiate View objects using the Instantiate button, it’s generally
a better idea to use the CustomView object for this purpose. By dragging a CustomView
into your application and reassigning its class, you have an object that can be positioned
and sized within a specific window of your application.

The Parse button displays an Open panel that lets you specify the class interface file you
want Interface Builder to parse. Interface Builder reads the specified interface data from
the file and then displays the name of the class in its proper location in the browser. Using
this command is equivalent to dragging the icon for the interface file into the File window,
as described earlier.

The Unparse button generates template class interface and implementation files for a class
you’ve created with the Subclass command. It writes the interface file based on the
outlets and action methods you defined for the class using the Class Inspector. It writes a
template implementation file, providing skeletal implementations for each of the class’s
action methods.

If you edit the files Interface Builder generates and then reissue the Unparse command,
Interface Builder can overwrite the edited files with new template files. Of course, Interface
Builder asks for verification before doing so.
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Attaching Help to Objects

The Help Builder panel makes it easy to associate help text with any object in your
application’s user interface. (To learn about the design of the NeXTSTEP help system, see
the NXHelpPanel class specification in the NeXTSTEP General Reference manual.)

The Help Builder panel is a slightly modified version of the standard Help panel.
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Attaching help to an object involves selecting an object in your application, displaying the
help text in the Help Builder panel, optionally selecting a help marker within the text, and
clicking the Attach... button. Thereafter, when the application runs and the user Help-clicks
the object (that is, holds down the Help key and clicks the object), the specified help text
will appear in the application’s Help panel. However, before you begin attaching help text
to your application’s objects, you must provide your application with two components: a
Help menu item and a Help directory.
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Interface Builder’s Menu palette supplies an Info menu item that, when dragged to your
application’s main menu, reveals a submenu containing a Help menu item. This menu item
is preconfigured to open the Help panel. (If you inspect the Help item’s connections, you’ll
see that it sends a showHelpPanel: message to the First Responder object.)

Project Builder can provide your application with the required Help directory. Choose the
Add Help Directory command in Project Builder’s Project menu to create this directory.
Project Builder creates the directory within the “.Iproj” directory of your chosen
development language (for example, English.lproj/Help). It copies into this directory
generic table-of-contents and index files.

The next step is to customize these files and to add content files of your own. The generic
help text that’s accessed through the supplied table-of-contents and index files gives help
on basic operations, such as using the mouse and choosing commands. You’ll want to add
files that describe the operations that are unique to your application. You can also override
or eliminate any of the generic help text that isn’t applicable to your application.

You create help files using Edit. (Make sure that Edit is in Developer Mode so that the Help
commands can be accessed from the Format menu.) Perhaps the easiest way to ensure that
the files you add agree in style and formatting with the generic help files is to display a
generic file, copy its contents, and paste it into a new Edit document. Be sure to resize
the new document’s window to the same width as the original so that the text will wrap
to the same margins. You can then modify the contents of the new help document and
save it in the Help directory. If you think you’ll want to associate objects with specific
passages within the file, rather than to the file in general, you can place help markers within
the document.

Each file you add should be represented by a new entry in the table-of-contents file.
(However, see the NXHelpPanel class specification for an exception to this rule.) After
adding content files, you’ll also probably have to update the index.

Once the table-of-contents, content, and index files for your help system are finished, you
can begin attaching help to your application’s user-interface objects. Display the Help

Builder panel by choosing the Help Builder command from Interface Builder’s Tools menu

or by clicking the Help Builder button in the Help display of the Inspector panel. Select an
object in your application’s user interface, locate the relevant help text in the Help Builder
panel, and click the Attach... button. If the Help inspector is open, it displays this new
association in its Help Attachments list.

The Help Builder panel offers several ways to locate specific portions of help text. First,
you can use the table-of-contents or index displays to locate a file. In addition, the pop-up
list below the Find field lets you search for help files by name, for marker names within the
help files, or for any string.
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Running Your Application in Test Mode

The Test Interface command puts Interface Builder in test mode. When you choose

this command, Interface Builder’s supporting windows disappear, leaving only those
windows that belong to your application. You can then test the operation of most objects
in your application.

Only those objects whose code has been linked into Interface Builder—primarily those
objects defined in the Application Kit and those coming from custom palettes—can be
exercised in test mode. This means that objects such as Windows, Buttons, and the
PrintPanel will operate as they would in a finished application. In test mode, your
application’s windows can be miniaturized, buttons will highlight when clicked, the
Print panel will operate as it should. Objects dragged from custom palettes will also
operate normally, since their code is dynamically loaded into Interface Builder when the
palette is loaded.

However, objects that have been declared in Interface Builder but whose code hasn’t been
linked into the Interface Builder application will not work as they would in a finished
application. For example, suppose you use Interface Builder’s Classes display to create a
new class, say the GaugeView class, and then assign the class of a CustomView in your
application to be the GaugeView class. When you run the application in test mode, the
GaugeView object will not appear since only its Objective C interface—not its code—is
available to Interface Builder.

When your application is operating in test mode, Interface Builder’s application icon
changes to display a large switch.

To exit test mode, either choose the Quit command in your application’s main menu (if
present) or double-click this switch icon.
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Setting Preferences

You open the Preferences panel by choosing the Preferences command in the Info menu.
This panel has two displays; you use the pop-up list at the top of the panel to access
these displays.

General Preferences

These preferences control which panels appear when Interface Builder is launched and also
whether a backup file is created when the nib file is saved.

“General -.il

Startup Optmns T
: Show palettes /|

Show mspectur_]

7 — Save Option ;.
. Create backup file when sawng_l

If the Save Option box is checked, Interface Builder will create a backup file whenever you
save a nib file that’s been modified. Assuming the box is checked, if you open a nib file
named FindPanel.nib, make changes, and then save the modified file, Interface Builder
will rename the original file FindPanel.nib~ before saving the modified file as
FindPanel.nib. Because of the safety of having a backup file, it’s generally better to leave
this box checked.
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Palettes Preferences

This display of the Preferences panel shows you which palettes are avaﬂable to Interface
Builder and lets you control which palettes are installed in the Palettes window.

Each palette is represented by an icon. The palettes that are already installed in the Palettes
window display their titles in gray; those that haven’t been installed display their titles in
black. Double-clicking the icon toggles the state of the palette: If it was installed, it’s
removed from the panel; if it was uninstalled, it’s installed in the panel.

When Interface Builder begins running, it loads the standard palettes (those displayed in
the top row of the illustration above) and then loads any palettes it finds in
/NextDeveloper/Palettes. It also adds to the Preferences display any palettes the user has
previously loaded using the Load Palette command. (Note: The information about these
manually loaded palettes is stored in ~/.NeXT/defaults.nibd.)

Adding Custom Palettes, Inspectors, and Editors

Interface Builder’s primary value as a development tool is that it lets you interact directly
with the objects that will make up your application. In general, these objects are defined
by the NeXTSTEP system software. However, it’s possible to extend Interface Builder’s
library of objects by creating custom palettes, thus letting you interact directly with objects
that you or other developers have created.
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A custom palette can contain objects of various sorts. Most commonly, a custom palette
contains View objects, objects that the user instantiates by dragging into a standard window.
It’s also possible to create custom palettes that contain MenuCells (which are instantiated
by dragging into a menu), Windows (which are instantiated by dragging into the
workspace), and other non-View objects (which are instantiated by dragging into the

File window).

For any custom palette object, you can provide one or more inspectors. A custom object’s
inspector appears in the Inspector panel when the user selects the object. Most custom
objects will require an Attributes inspector. For example, the fictitious RepeatButton class
mentioned earlier would probably require an Attributes inspector to let the user set the
repeat rate for a given button. It could also supply its own Connections, Size, and

Help inspectors, although the standard versions of these inspectors are generally adequate
for most uses.

Finally, a more complex custom object may require its own editor. An editor controls how
a user can interact with a selected object. Interface Builder itself supplies editors for the
objects it knows about. For example, when you double-click a window icon in the File
window, Interface Builder’s window editor is invoked and brings the actual window to the
front. Or, when you double-click a Form object in an application window, Interface
Builder’s matrix editor is invoked, letting you drag cells to new positions.

An editor that you provide must open its own window when the user double-clicks the
custom object. (In this respect, your editor will be like the one provided by the Database
Kit for the DBModule object. For a demonstration, load the palette
/NextDeveloper/Palettes/DatabaseKit.palette, drag a DBModule object into the File
window, and double-click the object.) Since each custom object can have its own

editor window, editors make copy and paste or drag and drop operations between editor
windows possible.

Creating custom palettes, inspectors, and editors involves working with Interface Builder’s
application programming interface (API). This API is described in detail in Chapter 8 of
the NeXTSTEP General Reference manual. You should also consult Chapter 18 of this
manual for a tutorial describing the process of making a custom palette and inspector.
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The remainder of this chapter gives short descriptions of Interface Builder’s commands.
Only those commands that are unique to Interface Builder are listed; for information on
commands that are common to all NeXTSTEP applications see the User’s Guide. '

Commands in the Document NMenu

These commands act to open, create, save, or test an Interface Builder document. (Interface
Builder documents are generally referred to as “nib files,” since that’s how they are stored -
on disk. However, until a document is saved, no file exists, so referring to the document as
a “nib file” isn’t strictly correct. Even so, for simplicity, Interface Builder documents are
referred to as nib files throughout, unless to do so would cause confusion.)

Command Description
Open Opens an existing nib file.
New Application Creates a new Interface Builder nib file containing the basic

components of an application: a main menu, a standard window,
and other resources. You rarely use this command since it’s
generally more convenient have Project Builder create the nib file
for a new application. See the description of Project Builder’s
New command in the previous chapter for more information.

New Module Opens the New Module menu, which offers commands for
creating various sorts of Interface Builder nib files other than the
type used for an application’s main nib file. See “Commands in
the New Module Menu” later in this chapter for more information.

Save Saves the current nib file. You can edit more than one Interface
Builder nib file at a time. Each open nib file is represented by a
File window: The File window that has main or key window status
identifies the current nib file.

Save As Saves the current nib file under a different file name.
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Save All

Revert to Saved

Test Interface

Saves all open nib files.

Restores the current nib document to the state represented in the
nib file. All changes made since the file was last saved are lost.

Puts Interface Builder in test mode. When you choose this
command, Interface Builder’s supporting windows disappear,
leaving only those windows that belong to your application. You
can then test the operation of the objects in your application. See
“Running Your Application in Test Mode” earlier in this chapter
for more information.

Commands in the New Nodule Menu

These commands let you create auxiliary nib files of various sorts. (The main nib file is
generally created by Project Builder.)

Command
New Empty

New Info Panel

New Attention Panel

New Inspector

New Palette

Description

Creates the simplest sort of nib file, one that includes references
only to a File’s Owner object and a First Responder object.

Creates an auxiliary nib file containing a panel that’s
preconfigured as a standard Info panel.

Creates an auxiliary nib file containing a panel that’s
preconfigured as a standard Attention panel.

Creates an auxiliary nib file containing the components you need
when creating an inspector for a custom palette project.

Creates an auxiliary nib file containing the components you need
for a custom palette project. You rarely issue this command
directly, since Project Builder provides this nib for you when you
create a new inspector project.
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Commands in the Edit Menu

Except for the Set Name command, this menu contains the standard editing commands:
Cut, Copy, Paste, Delete, and Select All. These commands work in the expected ways.
(See Chapter 15 for a tutorial introduction to Interface Builder’s basic commands.)

Command
Set Name

Description

Displays a panel that lets you set the name of the selected object.
With this name, and the NXGetNamedObject() function, you can
access objects by name within your application. However, it’s
generally a better idea to access objects through the use of outlets,
since outlets can be connected and disconnected in Interface
Builder, eliminating the need to alter your application’s code.

Commands in the Format Menu

This menu lets you set the font and formatting attributes of the selected object. It also gives
you access to the Layout menu and to the Page Layout panel.

Command
Font

Text

Layout

Page Layout

Description

Opens the Font menu. Interface Builder’s use of the Font menu
is entirely standard. By setting the font of a TextField or the
Text object within the ScrollView (for example), you are
determining which font the user will use in those objects when the
application runs.

Opens the Text menu. Interface Builder’s use of the Text menu is
entirely standard. By setting the text alignment or tab settings of
an object in Interface Builder, you are determining the alignment
and tab settings for those objects at run time. Note that the ruler
commands work only with a Text object that is the document view
of a Scroll View.

Opens the Layout menu, which is described in the next section.

Opens the standard Page Layout panel. This panel lets you specify
how the window you print using Interface Builder’s Print
command will appear on paper. Since a screen pixel is
approximately 75 precent of the size of a printer pixel, the image
of a window appears larger on paper than it does on the screen. To
compensate, set the scaling factor to 75 percent in the Page Layout
panel’s Scale field.
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Commands in the Layout Menu

This menu offers commands that help you manage the placement, size, and alignment of
View objects that you drag into your application’s windows.

Command
Bring to Front

Send to Back

Size to Fit

Same Size

Group

Group in ScrollView

Ungroup

Description

Establishes the selected object as the frontmost object in the
window. If the selected object intersects other objects, the selected
one is drawn over the others. If more than one object is selected
when you choose this command, the entire group of objects is
brought in front of all other objects in the window.

Puts the selected object or objects behind all other objects in
the window.

Resizes the selected object to the minimum size required to
display its contents. If more than one object is selected, each is
resized to its own minimum size. For an object of a given class,
minimum size may depend on the font used to display the title, the
alignment and location of the title, and the distance the content
area is offset from other areas of the object.

Forces one or more selected objects to assume the dimensions of
another selected object. The first object you select establishes the
dimensions that the other selected objects will assume.

Groups the selected object or objects in a titled box. The box is
sized so that it just accommodates the objects in the group.
Groupings are often used within panels to organize the display of
similar items. The grouped objects become the subviews of the
Box object that contains them.

Groups the selected object or objects in a ScrollView. The
ScrollView is sized so that it just accommodates the objects in the
group. The grouped objects are made subviews of the ScrollView.

Removes the grouping established by the Group or Group in
ScrollView commands. '

(continued)
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Command
Make Row

Make Column

Turn Grid On / Off

Show Grid / Hide Grid

Alignment

Description

Aligns the selected objects horizontally. The row extends to the
right of the selected object that’s nearest the top left corner of the
window. The spacing between objects is determined by the
original spacing between the two objects nearest the window’s top
left corner. If these objects originally overlapped, the objects in
the resulting row abut each other.

Aligns the selected objects vertically. The column forms below
the object that’s nearest the top left corner of the window. The
spacing between objects is determined by the original vertical
spacing between the two objects nearest the window’s top left
corner. If these objects originally overlapped, the objects in the
resulting column abut each other.

Enables and disables the alignment grid in all windows of all open
nib files. When the grid is enabled, View objects dragged into a
window are constrained in their location and dimensions to the
units defined by the grid.

By default, the intersections of the grid are aligned, both vertically
and horizontally, on every eighth pixel in a window. Also by
default, an object’s lower left corner is the reference point for
alignment with the grid. (The grid spacing and the object’s
reference point can be changed using the Alignment panel.)

Setting the grid on has no immediate effect on objects placed in the
window when the grid was off. Their location and dimensions are
unchanged until you attempt to move or resize them.

Displays and hides the alignment grid in all windows of all
open nib files. The grid is displayed as a rectangular array of dark
gray dots.

Opens the Alignment panel, which is described in the “Using the
Alignment Panel” section earlier in this chapter.
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Resize Window Makes any application window resizable. During application
development, windows that will be resizable at run time display a
resize bar. To establish the run-time size of such a window, simply
adjust it using the resize bar. Windows that won’t be resizable at
run time don’t display this bar. The Resize Window command lets
you adjust the size of such windows by making them temporarily
resizable.

When you choose this command (or click the resize button 4 in
a window’s title bar), the window’s resize button highlights and
the window can be resized. For windows that won’t be resizable
at run time, a resize bar temporarily appears so that you can adjust
the window’s size. After you resize the window (or click
anywhere within it), the bar disappears.

Commands in the Tools Menu

This menu’s commands open or bring to the front the named panel.

Command Description

Colors Displays the Colors panel.

Inspector Displays the Inspector panel.

Palettes Displays the Palettes panel.

Load Palette Presents an Open panel, enabling you to load additional palettes

into Interface Builder’s Palette window. See “Setting
Preferences” earlier in this chapter for more information.

Help Builder Displays the Help Builder panel. This panel will be empty unless
your application is part of a project containing a Help directory.
See “Attaching Help to Objects” earlier in this chapter for
information on using the Help Builder panel.
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1he Edit Application

In addition to the standard UNIX editing tools (vi, ex, ed, and GNU Emacs), the
NeXTSTEP development environment provides a mouse-based text editor named Edit for
creating and editing ASCII or RTF (Rich Text Format®) text files.

Edit has all the standard features of a text editor: You can type paragraphs of text without
pressing the Return key (the text wraps automatically at the end of each line, and if you
change fonts or resize the window, the text rewraps accordingly). You can use the mouse
to select where text will be entered and to select text you want to edit. And you can find
and replace text, move and copy it, and so on.

While Edit has the functionality of a good text editor, it’s particularly suited for writing
programming code and performing other application-development tasks. It lacks many
of the capabilities found in similar applications, but it has many features specifically
designed for programmers. For example, Edit supports name expansion, folder browsing,
block nesting in program listings, and a structured editing facility. It also provides
interapplication functionality with Project Builder, Terminal, and the GDB debugger.
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You can start Edit from the workspace as you would start up any other application.
Alternatively, you can start up Edit from a shell window by typing the following command

at the UNIX prompt:
Edit [file name ...] &

Several command-line options allow you to override various default characteristics of Edit
for the work session you’re about to start—characteristics such as the number of lines and
columns in new windows, the font family used, and the font size. For example:

Edit -NXFont Times-Roman Fruit.m &

These command-line option‘s can be specified in any order, as long as they precede any file
names. Several options are listed below.

Option
IndentWidth

NXFont
NXFontSize

Tags

DeleteBackup

NXMenuX

NXMenuY
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Effect

Specifies the width of indentation for block nesting. The default
value is 4.

Specifies the font family. The default font is Helvetica®.
Specifies the font size, in points. The default value is 12.

Specifies one or more pathnames to tags files that will be searched
by the Source command. The pathnames should be separated by
a colon, as in a standard UNIX path list. The default is “tags,”
which indicates that the tags file in the current folder will be
searched. See the description of using tags files under “Interacting
with UNIX” later in this chapter for more information about using
tags files in Edit.

Specifies whether the previous version of a file is deleted or
retained as a backup when you save changes to the file. The
default value is YES, which means that the previous version is
deleted. If the previous version is saved as a backup, its name is
the same as the original file name, but with a tilde (~) appended to
the name.

Specifies the (positive) distance in pixels from the left edge of the
screen to the left edge of the main menu.

Specifies the (positive) distance in pixels from the bottom of the
screen to the top of the main menu.



Edit will use the default value for each option unless you override it with a command-line
option. The value specified in the command line will remain in effect only for the

work session you’re about to start. The next time you use Edit, the defaults will go back
into effect.

You can set new default values for each of the above characteristics (except for screen
coordinates) using the Preferences panel, which is described in the following section. Most
defaults set with the Preferences panel remain in effect until you change them.

Setting Preferences

The Preferences command in the Info menu displays the Preferences panel, shown below.
The Preferences panel lets you set default values for various Edit options. For example,
you can set default font properties or specify the size of new windows.

Preferences

—ees Startup Editing ey
(" User Mode
-~ i Developer Mode

(== Open new documents in: ~—
" €I Rich Text Format (RTF)
C: Plain Text (ASCIl) -

Rich Text Fon
Name: Helvetic
Size: 12

—— ASCII Fo
-, Name: Ohlfs-
=l - Size;10

Enter values and click buttons to specify new preferences, as described below. Then click
Set to set the new preferences (or click Revert to restore the previous settings). In general,
the new settings remain in effect until you change them. However, you can temporarily
override some of the defaults by starting up Edit from a shell window and specifying one
or more command-line options (as described earlier under “Starting Edit”).
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User Options

[C Options

You can press the button labeled User Options and, in the list that appears, choose from
several other sets of options that are available. These other options are described below,
after the user options.

User Options

Choose User Options in the Preferences panel’s pop-up list to see the user options that can
be specified. User options are saved in your defaults database and continue to be used until
you specify different values for them.

— Startup Editin: —
 CyUserMode

 Opeveiperode

By default Edit starts up in User mode, which presents just a subset of the commands
available in Developer mode. If you’re using Edit for application development be sure to
click the Developer Mode button.

Click one of these buttons to specify whether new documents are created in RTF (Rich Text
Format) or ASCII format.

Tip: After you’ve created or opened a document, you can change its format by choosing
the Make Rich Text command or the Make ASCII command in the Text menu.
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Rich Text Font
- Name: Helyetica

Size 12

Click the Set Button in the Rich Text Font field to set a default font for Edit windows that
are in RTF format. Specify the font family, typeface, and size in the Font panel that appears,
and click the Set button in the Font panel when you’re done. After you save these settings,
all subsequently created RTF documents will by default display text in the specified font.

— ASCIl Font ———————.
s Name: Ohlfs :

Slze 1o

Click the Set Button in the ASCII Font field to set a default font for Edit windows that are
in ASCII format. Specify the font family, typeface, and size in the Font panel that appears,
and click the Set button in the Font panel when you’re done. After you save these settings,
all subsequently opened Edit windows that containing ASCII files will display text in the
specified font. :

Tip: When working with code or UNIX command output, it’s best to use a fixed-width font
family, such as Courier.

Global Options

Choose Global Options in the Preferences panel’s pop-up list to see the global options that
can be specified. Global options are saved in your defaults database and continue to be used
until you specify different values for them.

e - Save Option
C Delete backup file

('“wDon*t delete backu

When the “Delete backup file” option is selected, Edit automatically deletes the previous
version of a file when the current version is saved. Click “Don’t delete backup file” to retain
the previous version of a file when you save the current version (if the previous version of
a file is saved). This backup file is saved under the original ﬁle name, but with a tilde (~)
appended to the name.
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If you try to save a file that’s write-protected, you can do so by responding affirmatively to
the confirmation panel that appears (as long as you own the file). Check the Save Files
Writeable button if you want such write-protected files to lose their write-protected status
when they’re saved.

Width field and a height (in number of lines) in the Height field. Edit files that you open

after saving these settings will be displayed in windows with the dimensions you specify.

(Note that since these dimensions are specified in characters and lines, the default window
size will be affected by the default font.)

Click one of the buttons in the Emacs Key Bindings field to specify whether or not Emacs
key bindings are enabled. For alist of the Emacs key bindings available in Edit, see “Using
Keyboard Editing Commands.”

Temporary Settings

Choose Temporary Settings in the Preferences panel’s pop-up list to see the temporary
settings that can be specified. These are called temporary settings because they re not saved
in your defaults database.

e T e e

When the “Word boundaries” option is selected, text wraps onto the following line at the
end of each full line, but no words are split across lines. Clicking “Character boundaries”
also causes text to be wrapped at the end of each line, but words can be split across lines.
Clicking “Don’t wrap” causes text to not wrap at all.
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———=— Rich Text Options —=——7.
. (CVEdit Rich Text Farmat ;
- (Clgnore Rich Text Format |

When the Edit Rich Text Format option is selected, RTF files that you open are displayed
as formatted text. Click Ignore Rich Text Format to view RTF files as unformatted text with
the format commands visible. Because other applications use Edit to view formatted text,
you should normally leave the Edit Rich Text Format option selected.

Text Options

Choose Text Options in the Preferences panel’s pop-up list to see the text options that can
be specified. Text options are saved in your defaults database and continue to be used until
you specify different values for them.

7 Automatic Indentin
- Ci-Automatically indent lin
. (C Dontauto-indent lines

‘When the “Automatically indent lines” option is selected, Edit indents each new line the
same as the line above it (automatic indentation is useful for typing indented lines of code).
Click “Don’t auto-indent lines” if you want each new line to start at the left margin.

= BStructure Level of Blank Lines =
- ) sameas previous line &
- (ChDetermined by indentation’ . ||

When the “Same as previous line” option is selected, Edit assigns each “blank” line (that
is, each line that contains no visible text) the same structure level as the previous line. Click
“Determined by indentation” if you want the structure level of blank lines to be determined
by the amount of indentation (that is, tabs and spaces) on that line, rather than by the
indentation of the previous line.

— Alignment ———
" incharacte

It

Text menu’s Nest and Unnest commands. In the Tabs field, enter the number of characters
you want between tab stops.
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In the ASCII and RTF fields, enter a number between 0 and 99 to specify how many levels
of structure will be visible in a newly opened file of that type. A 0 indicates that only the
top level of text (that is, text that’s flush left) will be visible, a 1 indicates that the first
sublevel of text should also be visible, and so on.

CFileTexto,hm
LispFileText:cllisp

FOH K, 204,008

In addition to the default Text mode, there are two editing modes for C and Lisp source files
(these modes optimize some minor aspects of Edit’s behavior for use with each of these
programming languages). You can specify in the Modes field any additional file extensions
that you want associated with either of these two modes.

C Options

Choose C Options in the Preferences panel’s pop-up list to see the C source code options
that can be specified. C options are saved in your defaults database and continue to be used
until you specify different values for them.

~—_ Structure for Top Level —
O;Determined by st character

When the “Independent of lst character” option is selected, commands in the Structure
menu operate solely on the basis of indentation, independent of particular characters. Click
“Determined by 1st character” if you want Structure menu commands to treat C
preprocessor directives (lines whose first character is #) specially—that is, as second-level
text, rather than top-level.
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= Structure Level of Blank Lines
- Chsame as previous line ‘
: C}*Determmed by indentation

When the “Same as previous line” option is selected, Edit assigns each “blank” line (that
is, each line that contains no visible text) the same structure level as the previous line. Click
“Determined by indentation” if you want the structure level of blank lines to be determined
by the amount of indentation (that is, tabs and spaces) on that line, rather than by the
indentation of the previous line.

e Tags Path
ags:./tags

I8
i
H
"
'
{
|

In the Path field, enter the pathname of one or more tags files that you want Edit to search
when you choose the Source command in the Utilities menu. A tags file, which you create
using the UNIX ctags command, contains the locations of program object definitions
among a given group of files. The Source command searches the tags files specified here
for the location of an object definition and then opens the file containing the definition.

If you leave the default entry of “tags:../tags” in this field, Edit will search only the tags files
in the current folder (the folder containing the file in the main window) and in the current
folder’s parent folder. You can replace or add to the default, however, by entering the
pathnames of one or more other tags files; you separate multiple pathnames with a colon
as in a standard UNIX path list.

See the description of the Source command in “Commands in the Utilities Menu” later in
this chapter for more information about using Edit’s Source command with tags files.

/usr/mclude /NextDeveluper/
o |Headers /NexlDeveloper/Hea ¢

The Include Path field displays your default include path (the path the preprocessor uses to
search for system header files). You can redefine this path by edltmg the text and then
clicking the Set button.
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This section summarizes several basic Edit concepts and operations. For more information
about basic operations common to Edit and other standard NeXTSTEP applications, see the
User’s Guide.

Opening Edit Files

In addition to opening Edit files from the workspace, you can open them from within Edit
by using the Open or Open Selection commands in the File menu. (These commands are
described later in the chapter.)

An alternate way to open one or more files is to use Edit’s openfile command at the UNIX
prompt in a shell window. You can specify one or more file names (or pathnames), which
are interpreted relative to the shell window’s current folder. For example, the following
command would open all the files in the current folder that end with a “.c” extension, plus
all the files in a subfolder called headers that end with a “.h” extension:

openfile *.c headers/*.h

Each file is opened in its own Edit window. Note that the openfile command can be used
only when Edit is running.

Using File Windows and Folder Windows

Edit provides two types of standard windows: file windows and folder windows. As in
other applications, there are also panels and menus:

Note: Unless otherwise specified, folder windows mentioned in this chapter are Edit folder
windows, not Workspace Manager folder windows.

An Edit file window displays a document file that you can view and edit. When you make
changes to text displayed in a file window, the version of the file on the disk isn’t affected
until you save the file with the File menu’s Save command. When a file contains unsaved
changes, the window’s title bar displays a partially drawn close button. If you miniaturize
a window containing unsaved changes, its miniwindow is highlighted in gray.
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An Edit folder window displays a list of the files and subdirectories contained in a folder.
You don’t edit the contents of a folder window; instead, you use the displayed folder listing
to find and select other files or directories to open.

Two special features are available in Edit folder windows:

* You can type a character to find and select the first item starting with that character. Each
additional character you type deselects the previously selected item and finds the first
item starting with the newly typed character. The commands in the Find menu can also
be used to find and select items in a folder window.

* You can double-click a file or folder name to open an Edit window displaying that file
or folder. This is equivalent to selecting the name and choosing the Open Selection
command in the File menu.

You can also open an Edit folder window by choosing the Open Folder command in the File
menu. The command displays a panel in which you enter the pathname of a folder to be
opened.

Selecting Text

Most operations in Edit are performed on the current selection, which appears either as the
insertion point (a blinking vertical bar) or as highlighted text.

You make selections using the standard selecting techniques: Position the insertion point
by clicking, and select a block of text either with multlple -clicks or by dragging with the
mouse, as outlined below.

Method Effect
Clicking Positions the insertion point where you click.
Dragging Selects text that you drag across. To select beyond what’s

currently displayed, drag past the edge of the window. The
contents scroll automatically and text continues to be selected.

Shift-clicking Selects from the insertion point, or extends or shortens a selection.

Double-clicking Selects a word. If you double-click one of a pair of matching
delimiters (parentheses, braces, or square brackets) the pair of
delimiters and the enclosed text are selected.

Triple-clicking Selects a line or paragraph.
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Finding and Replacing Text

The Find Panel command opens a panel that lets you locate the next occurrence of a
specified text string and optionally replace it with another string.

|/Replace [{{ Replace & Find |i{Previous

In the Find field, specify the text to be located. You can’t type tab or return characters in

the Find field, because of their other functions: Pressing tab moves the insertion point to

the “Replace with” field, and pressing Return begins the search for the text. To specify a

tab character in the text, type Alternate-Tab. Likewise, type Alternate-Return to specify a
carriage return character.

In the “Replace with” field, you may specify a replacement string. Then click one of the
panel’s buttons to perform the exact search operation you want, as described below. If the
end of the document is reached during a search, Edit continues searching from the
beginning of the document. When searching backward and reaching the beginning of the
document, Edit continues searching from the end.

When Ignore Case is checked, Edit doesn’t distinguish between uppercase and lowercase
letters when finding a match during the search. If Ignore Case is not checked, the search is
case-sensitive.

If the Regular Expression box is checked, Edit interprets the text in the Find field as a UNIX
regular expression (see the UNIX manual page for ed for information on regular
expressions). If this box is unchecked, the Find entry is taken as a literal string of text.
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- Replace All Scope -,
1 Q) Entire File
- (CvSelection

The Replace All Scope options specify whether Replace All applies to the entire document
(Entire File) or only to the current text selection (Selection).

Replace All

In the area that you specify, the Replace All button replaces all occurrences of the text
entered in the Find field with the text entered in the “Replace with” field. If the “Replace
with” field is blank, Replace All deletes all occurrences of the text. After a search with
Replace All, the Find panel reports the number of occurrences that were replaced.

After text has been found, click Replace if you want to replace the current selection with
the text in the “Replace with” field (or if the “Replace with” field is blank and you want to
delete the current selection).

Click this button to replace the current selection and find the next match. This button is a
shortcut to using the Replace button and then the Next button.

Click the Previous button to find the first occurrence of the Find entry searching backward
from the insertion point or the beginning of the current text selection.

Click the Next button to find the first occurrence of the Find entry searching forward from
the insertion point or from the end of the current selection. (Pressing the Return key has
the same effect, but with one difference: If you used the Find Panel command’s keyboard
alternative to display the panel, pressing the Return key causes the panel to disappear
instead of remaining on the screen.)
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Checking Spelling

| speting

i Forget é{Fl(nd Next |

The Spelling command opens a panel that lets you check the spelling of words, choose from
possible corrections, and modify the spelling dictionary. As a convenience, Edit doesn’t
open the Spelling panel as the key window, so that you can type to correct a misspelling
without having to click in the file window first.

To begin a spelling check from this panel, click Find Next. Spelling locates and selects the
next word not contained in the spelling dictionary. (Edit uses a systemwide 100,000-word
spelling dictionary that’s shared by other applications, such as Mail.)

The search for misspelled words is circular, so that all the text in the main window is
searched. The search starts at the word containing the insertion point, or at the last word
in the current selection, and goes to the end of the text. If no potentially misspelled words
are found, the search continues at the beginning of the text until it comes back to the
starting point.

The Spelling panel displays a list of possible corrections to the last word selected as
misspelled (unless the word is completely unrecognizable). Double-clicking one of them
will replace the selected word in the main window with the desired correction.

The Learn and Forget buttons let you remove or add words from the spelling dictionary. If
a correctly spelled word is identified as misspelled, you can add it to the dictionary by
clicking Learn. You can also remove any word you’ve added to the dictionary, by selecting
it and clicking Forget.

14

To search for the next misspelled word, click Find Next (or choose the Check Spelling
command from the menu).
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Contracting and Expanding Text in a File Window

Edit provides a Structure capability that lets you quickly move around in C files (as well as
in any other type of file where levels of structure are represented by varying degrees of
indentation—outlines, for example). Commands in the Structure menu can be used to
“contract” text in the main window, displaying only the text at a particular level of
indentation. Text that’s indented beyond that level is hidden. Figure 4-1 shows a document
that’s been contracted—only the top-level lines (those that are flush left) are visible. Notice
the two white text arrows, which indicate the presence of contracted text.

// drawSource creates the source image in the source bitmap. Note that
/f drawSource does notrender in the view; it renders in the bitmap only.

-drawSource
{ | mams )

}

// drawDestination creates the destination image in the destination bitmap.
# Like drawSource, drawDestination only draws in the bitmap, notthe view.

-drawDestination
{ —

Figure 4-1. File Window with Just First-Level Text Expanded

When text is contracted, only the display is changed—the document itself (including font
changes and text properties) remains unchanged. However, while some Edit commands
affect both the expanded and the contracted portions of the document (for example, Cut and
Paste), other commands affect only the portions of the document that are expanded (for
example, commands that change the font).

Commands in the Structure menu let you expand or contract either the entire contents of
the window, or just the current selection. The rest of this section describes some mouse
shortcuts that you’ll probably use even more frequently than the menu commands.
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Clicking a text arrow expands (that is, displays) the text that the arrow represents.
Control-clicking a text arrow expands just the top level of the text that the arrow represents.
For example, Figure 4-2 shows what the drawSource definition looks like after
Control-clicking the first of the two text arrows shown in Figure 4-1. Notice that the
drawSource definition has expanded, but the drawDestination definition is still
contracted. Also notice that the drawSource definition hasn’t expanded completely—the
switch statement contains yet another level of contracted text.

* CompositeView.m — /NextDeveloper/ExamplesfCompositeLah-C-
drawSource

[source lockFocus);

PScompositerect (0.0, 0.0, sRect.size.width, sRect.size.height, NX_CLEAR);
PSsetgray(sourceGray);

PSsetalpha{sourceAlpha);

PSnewpath();

switch (sourcePicture) { ==

}
PSclosepath();
PSHlI();
[source unlockFocus};
return self;
7 drawDestination creates the destination image in the destination bitmap.

7 Like drawSource, drawDestination only draws in the bitmap, not the view.

drawDestination

Figure 4-2. File Window with Some Second-Level Text Expanded
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Figure 4-3 shows the drawSource definition after Control-clicking the switch statement’s
text arrow. Each case statement in the switch contains an additional level of contracted
text. The text for CIRCLE, however, isn’t contracted—it’s already been expanded by
clicking (or Control-clicking) its text arrow.

-drawSource

[source lockFocus);
PScompositerect (0.0, 0.0, sRect.size.width, sRect.size.height, NX_CLEAR);
PSsetgray(sourceGrayy);
PSsetalpha({sourceAlpha);
PSnewpath();
switch (sourcePicture) {
case TRIANGLE: =
case CIRCLE:
PSscale (sRect.size.width, sRect.size.height);
PSarc (0.5, 0.5, 0.4, 0.0, 360.0); // diameter is 80% of area
break;
case DIAMOND: =
case HEART: ==
case FLOWER: =

default: =
1
PSclosepath();
: PSAill();
%j [source unlockFocus;
: s

g

Figure 4-3. File Window with Some Third-Level Text Expanded

If you want to recursively expand all the sublevels of text represented by a text arrow, click
the arrow instead of Control-clicking it.

Control-clicking anywhere within an indented block of text contracts the text.
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Using the Ruler
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Edit provides a ruler that can be used to alter the format (margins, indentation, and tab
stops) of text in a file window. The Text menu (a submenu of the Format menu) contains
commands for showing the ruler and copying ruler settings, as well as commands for
centering or otherwise aligning text between the margins.

left margin right margin
marker marker
AL —— S —
indentation—%_"p - p F b P P P b b ¥y
marker | g7 | ERER I FRLER S S ) PYRLIREN ERSIn PATLILE IRCEN B YL SR AR U IR P
body indentation tab marker
marker

To display the ruler, choose the Show Ruler command from the Text menu (this command
is enabled only if the file window contains text in RTF format). The ruler settings show
the format of the paragraph that contains the insertion point or the beginning of the
selected text.

You can move margin, indentation, and tab markers by dragging them along the scale of the
ruler. When you move a marker in the ruler, a vertical gray line appears, running from the
marker to the bottom of the window. This line makes it easier for you to determine the
position of the marker relative to the text.

There are two important things to note about the margin settings:

* The left and right margin settings affect the entire text. Thus the margin settings,
whatever they may be, will always be uniform throughout a file.

* The right margin adjusts to match the width of the window: If you resize the window
wider, the right margin marker moves to the right and the lines of text become longer;
narrowing the window moves the right margin marker to the left.

Tab stops and indentation may be customized for individual paragraphs. Unless you
specifically change the tab stops and indentation, each new paragraph you type will
have the same tab stops and indentation as the preceding one. If you move or copy a
paragraph (including the Return at the end of it), the paragraph will keep its original tab
stops and indentation.

If you want to change the tab stops or indentation of a single paragraph, you need only click
in the paragraph; you don’t have to select the entire paragraph. After you make your
changes, the paragraph becomes selected. When you’re ready to type again, just position
the insertion point where you want to enter text.
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When several paragraphs are selected, the ruler displays the format of the first one. If you
then change a ruler setting, the selected paragraphs will receive not only that ruler setting,
but all the formatting of the first paragraph. You can also copy the format of one paragraph
to other paragraphs with the Copy Ruler and Paste Ruler commands in the Text menu.

Note: If you copy formatted text from Edit into another application, the formatting will be
copied along with the text only if the application can interpret RTF.

Margins [

The margin markers determine the left and right margins of the entire Edit file. To set the
left or right margin, drag the corresponding margin marker to the desired position on the
ruler. As you drag the left margin marker, the tab and indentation markers move with it,
remaining the same distance relative to the left margin.

Indentation T ~

There are two indentation markers:

T The first-line indentation marker indents the first line of a paragraph.
+* The body indentation marker indents all the rest of the lines of the paragraph.

The two indentation markers move independently; adjusting one does not affect the other.
Initially, both indentation markers are aligned with the left margin marker. Neither
indentation marker can be moved to the left of the left margin marker.

The relative positions of the two indentation markers determine the style of paragraph
indentation:

* Dragging the first-line indentation marker to the right of the body indentation marker
creates a regular paragraph indentation.

* Dragging the first-line indentation marker to the left of the body indentation marker
creates a hanging indent.

* Dragging both the first-line and the body indentation markers to the same position
indents the entire paragraph.

Changing the left margin of the text doesn’t affect indentation. Both indentation markers
move with the left margin marker, maintaining the same distance from it.
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Tabs !

Tab markers set the locations of tab stops—the positions that the insertion point will
advance to if you press the Tab key. Typing proceeds normally (from left to right) after the
tab, which lets you align columns of text vertically along the left side.

Initially, the ruler displays ten tab markers set eight spaces apart. Note that these initial tab
markers may not line up exactly with the calibration marks on the ruler’s scale.

To reposition a tab stop, drag the tab marker to the desired position on the ruler. To create
a new tab marker, click below the scale of the ruler: The marker will appear on the ruler
above where you clicked. You can remove a tab marker by dragging it off the left or right
end of the ruler.

Like indentation, tab stops adjust accordingly when you move the left margin marker.

Adding Linked Graphics
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You can add linked graphic images to an Edit document, so that whenever the original
images are modified, the linked copies you added can be updated automatically.

To link graphics from another application into Edit, the application used to create the
graphic image must be able to supply linked information. The Draw application (in
/NextDeveloper/Demos) is an example of such an application. (Some applications can
supply linked information that isn’t a graphic image, such as text or database information.
You add this information to a document in the same way that you add linked graphics.)

To paste a linked graphic in an Edit document, copy the graphic in the source apphcatlon
and then choose the Paste and Link command in Edit’s Link menu.

The Link Inspector command (also on the Link menu) opens the following panel, which
you use to maintain and update the links you create. Using this panel you can open the
source document, update the linked graphic, break the selected link, or break all links. In
addition, you can specify how to update the link when changes to the source graphic occur.
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For more information about working with linked graphics, see Chapter 11, “Working with
Graphics,” in the User’s Guide.

Adding Help Links

The Help menu in Edit provides commands that are used to add or edit Help links.
Although Help links are designed for use within an application’s on-line Help system, they
can also be used more generally (for example, the Contents file for the on-line developer
release notes contains links to the various release note files). For information about adding
a Help system to an application you’re developing, see Chapter 3.

To work with Help links and markers, use the following commands in the Help menu
(choose the Help command in the Format menu):

* Choose Insert Link to insert a Help link at the current insertion point. In the Link
Inspector that appears, specify the name of a file and (optionally) a marker in that file.

* Choose Insert Marker to insert a Help marker at the insertion point in the main window.
A Marker panel appears in which you specify a name to associate with the marker.
When you insert a link to the marker, you’ll identify it by this name.

¢ Choose Show Markers to show all the markers in the main window, or Hide Markers to
hide them.

If you want to edit a link or marker you’ve created, Command-click it to bring up the
Inspector panel. To delete a link or marker, select it and press the Delete key, just as you
would with text.
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Using Templates

Three commands on the Expert menu—Expansion Dictionary, Insert Field, and Next
Field—Ilet you for create and use glossary entries. Glossary entries are abbreviations for
commonly used text strings or templates that you can type and then expand into the full text
entry with a single keystroke.

To define a glossary entry, open the Expansion Dictionary panel by choosing Expansion
Dictionary in the Expert menu.

R ~ ExpansionDictionary - F ]

- Key]

- Expansion |

T, s =
S Add |$§ Remove |- ~Show |-

In the Key field, enter an abbreviation for the text string or template. In the Expansion field,
enter the expanded text that you want the abbreviation to represent. If you want the
expansion to occupy more than one line, press Alternate-Return while typing in the
Expansion field to insert Return characters between lines. Note that when you press
Alternate-Return, the line of expanded text you just typed disappears from the field, leaving
room to type the next line.

To use a glossary entry, type the abbreviation in a document and then press the Escape key;
the abbreviation is replaced by its expansion. For example, if you frequently need to type
setOutputForm, you could use the Expansion Dictionary command to associate the
abbreviation “sof” with the longer declaration. To enter setQutputForm, you would only
have to type sof and press Escape. The abbreviation doesn’t even have to be typed in

full for the expansion to occur, as long as what you do type refers unambiguously to a

glossary entry.
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If you’re using the Expansion Dictionary window to create a template containing fields
you’ll be editing after the text is expanded, surround each field with European quotes («»),
as described below. For example:

Subject: «subject»
To: «recipient»
CC: KCCH»>»

«message>»

You can enter European quotes in the Expansion field by choosing the Insert Field
command, or you can enter them directly from the keyboard by typing Alternate-( and
Alternate-). After inserting the template into a document, you can quickly find each
editable field by choosing the Next Field command, which positions the insertion point at
the next field in the template.

After entering the abbreviation and the expanded text it stands for in the Key and
Expansion fields, click the Add button to accept the new glossary entry.

Then to actually save the entry (so that it’s there for the next work session), click Save.

| Remove

To remove a glossary entry, type its abbreviation in the Key field and click the
Remove button.

You can view the expanded text associated with an abbreviation by entering the
abbreviation in the Key field and then clicking Show.

Click List to view a list of all available glossary entries.
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Using Keyboard Editing Commands

In addition to letting you edit text using menu commands (and their keyboard equivalents),
Edit also supports several Emacs-style editing commands that can be typed from the
keyboard. The table below lists the key combination corresponding to each of these
commands and a description of what the command does.

Command Action

Control-B Moves back one character

Control-F Moves forward one character
Alternate-b Moves back one word

Alternate-f Moves forward one word

Control-A Moves to beginning of line

Control-E Moves to end of line

Control-D Deletes next character

Control-H Deletes previous character

Alternate-d Deletes to end of current (or next) word
Alternate-h Deletes to beginning of current (or previous) word
Control-K Deletes forward to end of line
Alternate-< Moves to beginning of text

Alternate-> Moves to end of text

Control-N Moves down one line

Control-P Moves up one line

Interacting with UNIX

Edit provides some useful commands for using UNIX utilities from within Edit.
These include:

e Two commands for piping output from UNIX commands directly into Edit files

* A Source command that you can use with one or more tags files to locate program
objects in a group of files
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Piping UNIX Output to a File

Edit lets you pipe the output of a UNIX command directly into an Edit window. This is a
useful technique for inserting output from other applications into your own programs.

For example, to produce a 1992 calendar in an empty window, choose Command in the
Utilities menu, enter

cal 1992
in the panel that appears, and press Return. The output appears in an untitled window.

If instead you wanted the calendar to appear in the main window, position the insertion
point where you want the calendar to appear (or select what you want it to replace). Then
choose Pipe in the Utilities menu. Enter the same command as before and press Return.
This time the output appears in the main window at the insertion point or in place of the
current selection.

You can also use the Pipe command to manipulate the current text selection with another
UNIX program. If the command accepts input, the selection will be used as input—for
example, you could sort the selection with the sort command.

If there are Command and Pipe commands that you use frequently, you can define them as
menu items in the User Commands and User Pipes submenus in the Utilities menu. To do
this, enter a definition for each command in a file named .commanddict or .pipedict in
your home folder.

Each command definition contains at least two fields, separated by tabs:
command name<tab>command definition

For example, the following entry defines a Pipe command called Sort Selection, which runs
the UNIX sort command using the current selection as input:

Sort Selection sort -

One additional field (inserted between the two required fields and separated from them by
tabs) can be used to specify a keyboard alternative for the command. For example, this
definition of the Sort Selection command assigns to it the keyboard alternative
Command-5:

Sort Selection 5 sort -
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If you make changes to your .commanddict or .pipedict file while Edit is running, you
must quit and restart Edit in order for your changes to appear in the User Commands or
User Pipes menu.

Two special variables can be used as arguments to the UNIX commands you specify:

$file ’ This refers to the file that’s displayed in the main window (which
may be different from the contents of the window).

$selection This refers to the contents of the current selection, which can be
either text that’s selected in a file window or a file that’s selected
in a folder window.

Here are some examples of how these variables might be used in a .commanddict
definition:

Print Two Up P enscript -2r $file
GrepAppkit A fgrep -n "$selection” /ust/include/appkit/*.h

The first example prints the contents of the file that’s displayed in the main window.
The second example searches for occurrences of the selected text in the Application Kit
header files.

Using a Tags File

If you’re maintaining a large number of files as part of a programming project, you can use
Edit’s Source command with a tags file to quickly locate the definition of an object in that
group of files. A tags file (which you create with the UNIX ctags command) lists the
locations of program objects (such as functions, procedures, global variables, and typedefs)
that are in a specified group of files.

To locate an object definition, simply select it and choose Source (or choose Source and
type the object name in the panel that appears). Edit searches one or more tags files for the
location of the object definition and then opens the file containing the definition. Normally,
Edit searches the tags file in the current folder (the folder containing the file in the main
window). However, you can specify other tags files to be searched either with the
Preferences command or by specifying the Tags option when starting up Edit from a
shell window.

More information on tags files is given in the ctags UNIX manual page. For more
information on using the Source command, see the command description in “Commands
in the Utilities Menu” later in this chapter.
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Interacting with the GDB Debugger

A command named Gdb appears in the Edit main menu whenever you execute the GDB
view command (note that view is executed automatically by Project Builder when you ask
it to debug a project).

. Hellowortd  BX

Run Ghit l
f’c’bﬁtinu}el Step l ‘

" Finish | Next

———— Line —

* Break At l :Run Until !
— Selection ——

© Print | Print * I

:' Browse f’lm

The Gdb command opens the panel shown here, which lets you perform basic debugging
operations on a project and its source files. Commands not contained in the Gdb panel can
still be accessed by using the GDB debugger directly, as described in Chapter 13.

Since the Gdb command is visible only under certain conditions and has more to do with
debugging a project than with editing a document, the Gdb panel is described in the section
“Debugging” in Chapter 2, “The Project Builder Application.”

Edit Command Reference

The following sections summarize the menus and commands available in Edit.

Commands in the Main Menu

Edit’s main menu contains the standard Info, Print, Windows, Services, Hide, and Quit
commands. The other commands and the submenus they open are described in the sections
that follow. Several standard commands are discussed here only in terms of their particular
use in Edit.
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Commands in the File Menu

Edit’s File menu contains the standard Open, New, Revert to Saved, and Close commands.
The other commands are described here.

Command

Save, Save As, Save To,
Save All

Open Selection

Open Folder
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Description

These are the standard commands for saving the contents
of the main window on the disk.

When you save a file, Edit first moves the contents of the
old version to a temporary backup file, which has the same
name as the previous file but with a tilde (~) appended to
it (for example, the backup file corresponding to Fruit.m
would be Fruit.m~). Next, Edit writes the new version of
the file and then it (normally) deletes the backup file. If
something happens that prevents Edit from saving the file,
however, the backup file remains so you can recover its
contents. Or, if you always want the backup file to remain
(even after the new version is successfully saved), you can
set the “Don’t delete backup file” option in the
Preferences panel.

While the file is being saved, “saving:” appears before the
file name in the title bar of the window (in the case of
small files, it appears only for an instant). Until “saving:”
has disappeared, don’t use the file (for example, don’t try
to compile or copy it).

Opens the file or folder currently selected in the main
window. Normally, you use this command on a selection
in a folder window. However, it also works on selected
text in a file window. The selected text must be either a
full pathname, or a file name or pathname relative to the
current folder (the folder containing the file in the main
window).

Displays a panel in which you enter the pathname of a
folder to be opened. When you click OK, the folder opens
in an Edit folder window. When the panel appears, Edit
displays the name of the current folder in the “Folder
name” field.



Commands in the Edit Menu

Edit’s Edit submenu contains the standard Cut, Copy, Paste, Delete, and Select All
commands, plus commands for opening the Link menu and the Find menu described below.
Other commands are described here.

Command
Undelete

Spelling

Check Spelling

Description

Reinserts the most recently deleted text, even if the text
hasn’t been put on the pasteboard. You can insert the
deleted text at a new location by positioning the insertion
point where you want to insert the text (or selecting text
that you want it to replace) and then choosing Undelete.

Opens the Spelling Panel for checking the spelling of
words in the main window. See “Checking Spelling.”

Has the same effect as clicking Find Next in the Spelling
panel—that is, it finds the next word not contained in the
spelling dictionary. See “Checking Spelling.”

Commands in the Link Menu

Edit’s Link menu provides the following commands for working with linked documents.
For more information, see “Adding Linked Graphics.”

Command
Paste and Link

Show Links, Hide Links

Link Inspector

Description

Pastes a copy of a graphic contained on the pasteboard,
but creates a link to the document that the graphic came
from, so that future changes to the original graphic will
affect the copy in the Edit document as well.

Shows (or hides) whether or not graphics are linked
by displaying a linked chain around the border of each
linked graphic.

Opens the Link Inspector panel.
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Commands in the Find Menu

Edit’s Find menu contains the standard Find Panel, Find Next, Find Previous, and Enter
Selection commands. Other commands are described here.

Command
Jump to Selection

Line Range

Description

Scrolls the insertion point or current text selection
into view.

Opens a panel that identifies by number the line or line
range containing the current selection in the main
window. If the Character option in this panel is selected
instead of the Line option, then the character range is
displayed instead of the line range.

You can also use the panel to search for a particular line,
line range, character, or character range in the main
window. Enter a number or a range (a range is two
numbers separated by a colon) in the Range field. Click
the Select button to select that character, line, or range of
the file.

Commands in the Format Nienu

The Format menu contains commands for displaying the standard Font and Text menus, as
well as Edit-specific Help and Structure menus. Commands on these menus are described

later in the sections that follow.

Command
Page Layout
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Description

Displays the standard Page Layout panel for choosing
among various paper sizes, scaling factors, and
orientations for text printed from the main window.

When you print text that’s displayed in a window, the
printed words wrap exactly as they’re wrapped on the
screen. Therefore, if you change the page layout, the
width of the window may also need to be changed in order
for the text to print correctly. Changing the page layout
doesn’t affect the size of the main window, so you’ll need
to make this adjustment.



Commands in the Font NMenu

The Font menu contains the standard Font commands, plus a few additional commands that
let you change the font properties of the text displayed in the main window—for example,
the Colors command opens the standard Colors panel, which you can use to change the
color of the selected text.

In an RTF file, font changes apply to the current selection and are saved when you save the
contents of the window. In an ASCII file, font changes are applied to the entire contents of
the main window—font changes in non-RTF files aren’t saved when you save the contents
of the window.

Commands in the Text Menu

Edit’s Text menu contains commands that let you change properties of the text displayed in
the main window. Some of these commands work only on text in RTF files; use the Make
Rich Text command if you want to change the contents of the main window from ASCII to
RTE

Command Description

Align Left, Center, These align the text with the left margin (ragged right),

Align Right center it between both margins, or align it with the right
margin (ragged left).

Make Rich Text, Changes the format of the text in the main window from

Make ASCII RTF to ASCII, or vice versa. In an RTF file, font changes

and other text properties (such as superscripting and
subscripting) can be saved as part of the file and displayed
along with the text.

Nest, Unnest These help you indent blocks of program code. Select the
program lines you want to indent and then choose Nest.
Each line in the selected program text will be indented the
default amount (four characters, unless you’ve specified a
different default value in the Preferences panel or
overridden the default when you started up Edit from a
shell window).

Unnest moves the selected lines the default number of
characters to the left, thus counteracting the effect of Nest.

(continued)
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Command
Show Ruler, Hide Ruler

Copy Ruler, Paste Ruler

Description

Show Ruler displays a ruler at the top of the main window,
and the Hide Ruler command removes it. With this ruler
you can set margins, tabs, and paragraph indentation. See
“Using the Ruler” for details.

Copy Ruler copies the ruler settings of the paragraph
containing the insertion point or the beginning of the
current selection, so that you can subsequently paste them
with Paste Ruler. It’s as though there’s a separate
pasteboard for the ruler, and Copy Ruler replaces what’s
already on it, just as Copy does for text.

Paste Ruler affects the paragraph containing the insertion
point or the current selection. It replaces the paragraph’s
ruler settings with the last ones you copied with Copy
Ruler. If the current selection spans more than one
paragraph, Paste Ruler replaces the ruler settings of all the
selected paragraphs.

These commands don’t require the ruler to be showing,
and they don’t change the contents of the pasteboard.

Commands in the Help Menu

The Help menu provides the following commands, which are used to add or edit Help links.
Note that although Help links are designed for use within an application’s on-line Help
system, they can also be used more generally (for example, the Contents file for the on-line
developer release notes contains links to the various release note files). For more
information about working with Help links and markers, see “Adding Help Links.” For
information about adding a Help system to an application you’re developing, see Chapter 3.

Command
Insert Link

Insert Marker

Show Markers,
Hide Markers
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Description

Inserts a Help link at the insertion point in the main
window.

Inserts a Help marker at the insertion point in the
main window.

Shows (or hides) all the markers in the main window.



Commands in the Structure Menu

The Structure menu provides commands that control whether certain portions of the text in
the main window are expanded (that is, visible) or contracted (that is, hidden). These
commands are useful for working with files that have a regular multilevel structure, in
which the various levels of structure are represented by varying degrees of indentation (for
example, an outline or Objective C language source code). See “Contracting and
Expanding Text in a File Window” earlier in the chapter for a detailed introduction to this
Edit feature.

Command Description
Contract All, Expand All  These contract or expand all the text in the main window.

Contract Sel, Expand Sel = These contract or expand the selected text in the main
window.

Commands in the Utilities Menu

Commands in the Utilities menu perform a variety of functions, such as providing an
interface to the UNIX shell and looking up info